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Cautions and Warnings

THIS SYMBOL INDICATES THAT
DANGEROUS VOLTAGE
RISK OF ELECTRIC ' & CONSTITUTING A RISK OF
SHOCK ® ELECTRIGC SHOCK IS PRESENT

DO NOT OPEN WITHIN THE UNIT.

CAUTION: TO REDUCE THE RISK OF ELECTRIC
SHOCK, DO NOT REMOVE THE COVER.
NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE
PERSONNEL.

THIS SYMBOL INDICATES THAT
IMPORTANT OPERATING AND
MAINTENANCE INSTRUCTIONS
ACCOMPANY THIS UNIT.

Installation and servicing should be performed only by qualified and experienced technicians to
conform to all local codes and to maintain your warranty.

CAUTION Use only with the supplied 12 V DC power adapter.

Regulatory Statements

FCC Compliance Statement

Information to the User: This equipment has been tested and found to comply with the limits
for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential area
is likely to cause harmful interference in which case the user will be required to correct the
interference at his own expense.

Note  Changes or modifications not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

Canadian Compliance Statement

This Class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la Classe A est conforme a la norme NMB-003 du Canada.
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Manufacturer’s Declaration of Conformance

North America

The equipment supplied with this guide conforms to UL 60950-1 and CSA C22.2 No. 60950-1.

Europe

The manufacturer declares that the equipment supplied with this guide is compliant with the
essential requirements of the EMC directive 2004/108/EC and the Low Voltage Directive (LVD)
2006/95/EC, and the RoHS Directive 2011/65/EU, conforming to the requirements of standards
EN 55022 for emissions, EN 50130-4 for immunity, EN 60950 for Electrical EQuipment safety,
and EN 50581 for assessment of electrical and electronic products with respect to the restriction
of hazardous substances.

CAUTION To comply with EN50130-4 requirements, a UPS
should be employed.

WARNING This is a Class A product. In a domestic
environment this product may cause radio interference in which
case the user may be required to take adequate measures.

Waste Electrical and Electronic Equipment (WEEE)

Correct disposal of this product (applicable in the European Union and
other European countries with separate collection systems).

This product should be disposed of, at the end of its useful life, as per
applicable local laws, regulations, and procedures.

Safety Instructions

BEFORE OPERATING OR INSTALLING THE UNIT, READ AND FOLLOW ALL
INSTRUCTIONS.

AFTER INSTALLATION, retain the safety and operating instructions for future
reference

1. HEED WARNINGS - Adhere to all warnings on the unit and in the operating instructions.
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2. INSTALLATION

* Install in accordance with the manufacturer’s instructions. Do not block any ventilation
openings.

* Installation and servicing should be performed only by qualified and experienced
technicians to conform to all local codes and to maintain your warranty.

* Do not install the unit in an extremely hot or humid location, or in a place subject to
dust or mechanical vibration. The unit is not designed to be waterproof. Exposure to
rain or water may damage the unit.

* Any wall or ceiling mounting of the product should follow the manufacturer’s
instructions and use a mounting kit approved or recommended by the manufacturer.

3. POWER SOURCES - This product should be operated only from the type of power source
indicated on the marking label. If you are not sure of the type of power supplied to your
facility, consult your product dealer or local power company. Protect the power cord from
being walked on or pinched particularly at plugs, convenience receptacles, and the point
where they exit from the apparatus.

4. HEAT - Situate away from items that produce heat or are heat sources such as radiators,
heat registers, stoves, or other products (including amplifiers).

Note  Operation Max temperature: 40°C (104°F).

5. WATER AND MOISTURE - Do not use this unit near water or in an unprotected outdoor
installation, or any area classified as a wet location.

6. MOUNTING SYSTEM - Use only with a mounting system recommended by the
manufacturer, or sold with the product.

7. ATTACHMENTS - Do not use attachments not recommended by the product
manufacturer as they may result in the risk of fire, electric shock, or injury to persons.

ACCESSORIES - Only use accessories specified by the manufacturer.
CLEANING - Do not use liquid cleaners or aerosol cleaners. Use a dry cloth for cleaning.

10. SERVICING - Do not attempt to service this unit yourself as opening or removing covers
may expose you to dangerous voltage or other hazards. Refer all servicing to qualified
service personnel.

11. REPLACEMENT PARTS - When replacement parts are required, be sure the service
technician has used replacement parts specified by the manufacturer or have the same
characteristics as the original part. Unauthorized substitutions may result in fire, electric
shock or other hazards.

CAUTION Do not alter the polarized or grounding plug.
A polarized plug has two blades with one wider than the other.
A grounding plug has two blades and a third grounding prong.
The wide blade or the third prong is provided for your safety.
When the provided plug does not fit into your outlet, consult an
electrician for replacement of the obsolete outlet.

CAUTION RISK OF EXPLOSION IF BATTERY IS REPLACED BY
AN INCORRECT TYPE. DISPOSE OF USED BATTERIES ACCORDING TO
THE INSTRUCTIONS.
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Note  USB Load condition: USB Ports (5 Vdc, Max. 500 mA).

Warranty and Service

Subject to the terms and conditions listed on the Product warranty, during the warranty period
Honeywell will repair or replace, at its sole option, free of charge, any defective products
returned prepaid.

In the event you have a problem with any Honeywell product, please call Customer Service at
1.800.323.4576 for assistance or to request a Return Merchandise Authorization (RMA)
number.

Be sure to have the model number, serial number, and the nature of the problem available for
the technical service representative.

Prior authorization must be obtained for all returns, exchanges, or credits. ltems shipped to
Honeywell without a clearly identified Return Merchandise Authorization (RMA)

Typographical Conventions

This document uses the following typographical conventions:

Font What it represents Example
Helvetica Keys on the keyboard Press Ctrl+C
Lucida Values of editable fields that are mentioned in the The Time from field can be set to

body text of the document for reference purposes,  Hours:Minute:Seconds.
but do not need to be entered as part of a procedure

Text strings displayed on the screen The message Unauthorized displays.

Syntax (object) entered

Swiss721 BT Bold Words or characters that you must type. The word  Enter the password.
“enter” is used if you must type text and then press
the Enter or Return key.

Menu titles and other items you select Double-click Open from the File menu.

Buttons you click to perform actions Click Exit to close the program.

www.honeywell.com/security



Font

What it represents

Example

Italic

Placeholders: words that vary depending on the
situation

user name

Cross-reference to external source

Refer to the System Administrator Guide.

Cross-reference within document

See Chapter 2, Installation.
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Overview

This document introduces the HREP2 4-, 8-, and 16-Channel Digital Video recorders and covers
how to install and operate these DVRs.

This document is intended for system integrators, installers, and end-user operators.

Safety Instructions

The Company shall not have any responsibility for any accident or damage that may incur
during the use of the product. For your safety, we provide a few instructions about installation,
manipulation, cleaning, assembly/disassembly of the product as below. So please read
carefully and comply with the instructions.

Before Installation

Comply with the following instructions to prevent a fire, explosion, system
failure or electric shock.

¢ Remove the power supply module before proceeding.

*  Check the input voltage (AC100V-AC240V) to the power supply module before
connecting it.

*  Keep the product away from humidity.

¢ Ensure that all devices connected to the product are properly earth-grounded.

In Operation Mode

Comply with the following instructions to prevent a fire, explosion, system
failure or electric shock.

* If you need to open the cover, consult with a service person who could help you do what
you want to do.

* Do not connect multiple devices to a single power socket.

* Keep the product away from dust or too much combustible substances (ex: propane gas).
* Do not touch it with wet hand.

* Do notinsert a conductor in the vent of the ventilation system.

* Do not apply excessive force to unplug the power cord.
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Disassembly & Cleaning

*  When cleaning on the surface, use a dry cloth.
* Do not wipe the product using water, paint thinner or organic solvents.

* Do never dismantle, repair or modify the product by your own.

During Installation

To prevent an accident or physical injury and to operate DVR properly, please
comply with the following instructions.

* Secure at least 18 centimeters of distance between cooling fan and wall for a proper
ventilation.

* |Install the product on a flat surface.

* Keep it away from direct sunlight or excessive temperature.

While In Use

* Do not apply force to or shake it while using it.
* Do not move, throw away or put excessive force to it.

* Using any unrecommended HDD may cause a system failure. Check the compatibility list
and use only compatible HDDs.

Note A system failure or data loss caused by an incompatible HDD will void your
warranty.

Key Features

This product is capable of receiving inputs from up to 16 channels of 960H camera inputs of
video and audio and recording onto a hard disk drive in real-time, as well as providing
monitoring, playback and backup feeds in excellent quality of 960H resolution.

It also provides transferring video and audio data to the networked external devices, which
allows remote monitoring environment for computers and mobile devices including cell phones.

* Upto 16 channels of 960H camera video can be displayed at 480 fps (NTSC) / 400 fps
(PAL) in real time.

e Upto 16 channels of 960H camera videos can be saved at maximum 480 fps (NTSC) / 400
fps (PAL).

* Simultaneous recording and playback of maximum 16 channels (at 120 fps @ 960H).
e Supports H.264 HP (High Profile) CODEC.

*  Auto alarm feature with self-diagnostics on the system (HDD S.M.A.R.T, system
temperature, network error, FAN error, and so on).

*  Supports dual streaming for remote access service.
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e Supports HDD extension (eSATA).

*  Various search methods (time, event, bookmark and thumbnail).
* Mass storage backup through USB port or FTP server.

e Supports remote access and search using web browser.

* Dedicated smart phone applications that can be used with iPhone and iPad, or on Android
operating system.

* 1080p Full HD GUI.

What’s Included

Remote Control (x1) DC 12V Adapter (x1) Power Cable (x1) Screws
and Batteries (AAA x2)

Quick Guide Conversion Adapter Adapter Cable Mouse (x1) User manual CD
(for 8-/16-channel) Retainer Clip (x1)
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Rear Panel

HREP24, 4-channel DVR

HREP28, 8-channel DVR

HREP216, 16-channel DVR

Table 1-1 Rear Panel Connection Descriptions

Description

Video input terminal for cameras.

Monitor video output port.

Exclusive port for SPOT output only (use HDMI cable to connect
to an HD monitor).

Port for audio input.

Port for speaker connection.

Power input port. Connect to a 12V adapter.

No. Name
1 VIDEO IN
MONITOR
2
SPOT OUT
3 AUDIO IN
4 AUDIO OUT
5 DC 12V
6 DIP Switch

Switch to change unit’s video standard between NTSC and PAL.
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No. Name Description
WAN(UPLINK) Network port for connection to the Internet, router or hub.
7 Port for connecting the dedicated network device.
LAN(DOWNLINK)
Note Do not share it with other device.
8 USB Used for connecting USB storage or mouse.
9 eSATA Connection port for external eSATA storage.
10 HD-MONITOR HD monitor video output port.
11 VGA VGA monitor video output port.
ALARM IN Alarm input signal port
RELAY 1/2 Relay terminal output port.
12 Ports for communication with external devices such as PTZ
RS-485
camera and system keyboard.
RS-232 Connection ports for signal cables to external devices such as

PTZ camera, POS and ATM devices.
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Remote Control at a Glance

LOGOUT

POWER Log out.

Turn the power on or off.
PANIC

SEARCH Start the emergency recording.

Display the search window.
ALARM
Show the alarm status with a popup
window.

ARCHIVE
Display the backup window.

SETUP

Function as channel selection Display the system setup menu.
button in live or playback mode. Or ID
used for entering the password. Set the remote control ID.
LOG
DISPLAY N AN Display the log list.
Switch the spilit screen display.
ENAPSHOT PREV/ NEXT \\g AUDIO

Display the audio channel selection
window.

KEYLOCK

Lock any operation on the unit.

RESERVE
Reserve the current video.

SEQ -
Switch to sequence mode.

SNAPSHOT
Take a snapshot of the video.

< <Pl >

. . on? MENU
Useot|ht2 Clh ange thde .dlrelctlgn T(r angSt y Oy o Display the tool bar on the live screen.
play speed in playback mode. -
zoom T N Focus F
- +
EXIT 9 e A V. <>
Exit from the current screen and Ny Use to move through the menus.
return to the previous screen. ~
ZOOM/PTZ
ENTER Enter the digital zoom or PTZ mode
Select a menu item or apply your and control the operation.
settings.

Change the Remote Control ID

The remote control will be active only if the remote control ID matches with the ID specified on
the DVR.

If multiple DVRs are installed on one place and you have just a single remote control, use the ID
button to set the remote control ID. Only the ID-matching DVR can be controlled.
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From SYSTEM » CONTROL DEVICE under the System Setup menu, set the REMOTE
CONTROLLER ID and press APPLY.

Select between 00 and 99. For more details, refer to System Setup on page 55.
Press the ID button on the remote control. The default remote control ID is 00.

Use the number buttons to provide a two-digit remote control ID. If you want to enter 01,
for instance, enter the number 0 and 1 in sequence.

Check if the remote control ID is set properly by manipulating the remote control and
checking that the functions pressed are performed on the unit.

To reset the ID to 00, press and hold the ID button.
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Installation

Basic System Layout

960H Camera -~ - 4/ Control /
- > Devices . 5 :
oD 59 €

Monitor SPOT
Alarm Sensor MIC
= S
7

Monitor

Mouse

a9 ay;

IP Rouer
orHUB DC 12V

Power

POS ATM  Access Full HD (RGB) Speaker ~ SPOT T
Controller Monitor Monitor

Note  Signal connection for POS and ATM is scheduled to be upgraded later.

CAUTION Since the quality of the cable may directly affect the video
quality, depending on the distance between the camera and DVR, it is
recommended to consult an authorized installer when installing the DVR.
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Connecting to an External Device

Connecting to the Monitor

This product supports 1080p 60 Hz HDMI monitors and regular monitors that support DVI and
VGA inputs. Use the switch on the product’s rear panel to set it for an HDMI or VGA monitor.
Connect an HDMI cable to the port on the product’s rear panel, or connect an HDMI-DVI
converter cable to connect to a DVI monitor. Or, use a VGA cable to connect the product with a
VGA monitor.

Once the product is set for NTSC or PAL, connect cameras of the corresponding video standard
for proper operations.

Setting the product to NTSC or PAL determines the unit’s video input and output standards (see
Figure 2-1).

Figure 2-1  Setting NTSC or PAL Video Standards

ou-z [l >
s I 2

Note  The monitor’s displaying operates at 50 Hz if the product has been set to PAL
output and the connected monitor supports both 50 Hz and 60 Hz inputs. For the
NTSC setting, it works at 60 Hz.

CAUTION Make sure to connect the product to a monitor that
supports 1920 x 1080 at 60Hz (HDMI, DVI, VGA).

Connecting Power

Plug the provided DC 12V adapter in the rear power port of the DVR. When done, attach the
Adapter cable retainer clip to the rear panel and insert the cable into the clip.
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Figure 2-2  Power Connection on Rear Panel

Adapter cable
retainer clip

DC 12V adapter

CAUTION For stable operation of the product, it is recommended
to use the provided adapter (12V, 5A).

CAUTION Make the connection before applying the power.

CAUTION Arrange up the cables and be careful not to peel off the
cable coating.

CAUTION Do not place the power cord under the carpet or rug.
The power cord is usually earth-grounded. However, even if it’s not
earth-grounded, never modify it on your own for earth-grounding.

CAUTION Do not insert multiple devices in a single power
socket. It may cause a power overload.

CAUTION For a stable power supply, this product provides two
separate adapters and two corresponding AC cords by factory defaulit.
Make sure all cables are connected properly.

Alarm Input/Output Connections

Connecting the Alarm Input Signal

Figure 2-3  Alarm Connections on the DVR Rear Panel

- x«m_,n& il .

PR (S, () N R fROE EUR AR IR

(=
iﬂmmhllnlul . e D I] ﬂ Ry £ CE

Connect the signal line of an alarm input device such as sensor to the rear panel ALARM IN
port.
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Push the Alarm IN and GND terminals’ bottom side inwards with a sharp tipped tool such
as a screwdriver.

While pushing inwards, insert one end of the alarm signal cable into the hole of Alarm IN
terminal.

While pushing inwards, insert one end of the ground cable into the hole of the GND
terminal.

To check proper insertion of the cable, stop pushing the terminal’s bottom side inwards
and gently pull the cable and test whether it disconnects.

Note  To disconnect a cable, push the bottom side of the terminal inwards and pull out
the cable.

Connecting the Alarm Output Signal

Connect the signal cable of the alarm output device to the RELAY 1/2 terminal on the DVR’s rear
panel.

1.

Push the NO/NC/COM terminal’s bottom side inwards with a sharp tipped tool such as a
screwdriver.

While pushing inwards, insert one end of the alarm signal cable into the desired terminal of
NO or NC.

* NO (Normal Open): Normally Open but switching to Close if an alarm out occurs.
e COM: Insert the grounding wire.

¢ NC (Normal Close): Normally Close but switching to Open if an alarm out occurs.
Insert the ground signal wire into the hole of the COM port.

To check proper insertion of the cable, stop pushing the terminal’s bottom side inwards
and gently pull the cable and test whether it disconnects.

Note To disconnect a cable, push the bottom side of the terminal inwards and pull out
the cable.

Communication Port Connection

Figure 2-4 Communication Port Connections on the Rear Panel
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Connecting an RS-485 Device

You can connect a PTZ Camera or Keyboard Controller through the RS-485 port. You can also
connect a text-in device such as a POS or ATM.

After connecting the control device, be sure to match the connection settings between the DVR
and device. Make the communication settings in the Control Device section (see Control Device
Settings on page 87).

1. Connect the signal cable to the RS-485 communication port on the DVR’s rear panel and
the D+ port of the PTZ camera/keyboard controller.

2. Connect the signal cable to the RS-485 communication port on the DVR’s rear side and
the D- port of the PTZ camera/keyboard controller.

Note For RS-485 communication configuration, refer to the user's manual of the
applicable PTZ camera or keyboard controller.

Note  Signal connection for POS and ATM is scheduled to be upgraded later.

Connecting an RS-232 Device

You can connect PTZ cameras, POS or ATM devices through the RS-232 port. For connection
of the text-in device, refer to the user manual of the text-in device.

Note  Signal connection for POS and ATM is scheduled to be upgraded later.

Audio Device Connection

You can connect an audio output device such as a speaker amplifier to the DVR rear panel.

Connect the audio input device such as a microphone to the rear panel Audio In port, connect
the audio output device such as a speaker amplifier to the Audio Out port.

800-15802 - A - 12/2013



38 | Performance Series HREP2 DVR User Guide

Storage and Mouse Connection

Figure 2-5 USB and eSATA Rear Panel Connections

External Hard Disk Drive USB Hard Disk Drive USB Storage USB Mouse

(for video recording) (for backup only) (backup, firmware
updating)

Connecting eSATA Storage

If the internal storage space is insufficient, you can expand your storage capacity by adding an
eSATA storage device to the rear panel eSATA port (see Figure 2-5).

Note  Using devices other than recommended eSATA products may cause serious
problem. Recommended eSATA products include: Sarotech C5-US3 external
eSATA device.

Connecting a USB Device
You can connect and use USB storage devices for backup of recorded video, saving snapshots,

firmware updating, and importing/exporting user configuration files. Also, a USB mouse can be
connected for DVR manipulations.

CAUTION If you need to connect a USB HDD with a high power
consumption, it is recommended to use a separate power source for that
HDD.

Network Connection

Connecting to a PC in the Local Network

You can connect the DVR to a PC in the same network and control or manipulate it using the PC
monitor, keyboard and mouse.
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Figure 2-6  Network Connection Overview

Broadband
router or hub

Camera

Local PC

Local PC
1. Connect the WAN(UPLINK) port in the rear panel to the router or hub (see Figure 2-7).

CAUTION The LAN (DOWN LINK) port is provided only for
connecting to the dedicated backup network device. (Do not connect

devices to this port.)

2. Connect the local PC to the router or hub (see Figure 2-7).

Figure 2-7  Connecting Router or Hub to the DVR

Mo}

o /o o,

©Q O\ O
e e e e\
i Broadband
O o router or hub
PWR RRSET
Local PC Local PC

3. Enter the address in the Web browser of your PC in the format of: http://IP address:Web
service port (for example: http://192.168.0.23:8080). The web service port is set
to 8080 by default. From the Network Setup screen, you can change the port number.

4. Provide the ID and password before logging in. Then, you can view the monitoring screen.
Access ID (factory default): ADMIN
Password: 1234
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CAUTION For security purposes, change the password before
you use the product for the first time after purchasing.

Connecting to a PC from a Remote Network

You can connect the DVR to a PC or mobile device in the same remote network and control or
manipulate it on the monitor of the PC or mobile device.

Figure 2-8 Remote Network Connection Overview

Remote PC Broadband

Router

Smart Phone .
Connection

Local PG
Local P‘C e
1. Connect the WAN(UPLINK) port in the rear panel to the router.

CAUTION The LAN (DOWN LINK) port is reserved and only for
servicing and development. (Do not connect devices to this port.)

Figure 2-9  Connecting Router for Remote Network Connection

- e e et TR
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Broadband
Router

ADSL Modem Local PC

2. Connect the WAN(UPLINK) port of the router directly to the fixed IP LAN cable, or connect
it to the ADSL modem (see Figure 2-9).
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If using the router, set the port forwarding and enter the DDNS address in the address bar
(web browser) of the remote PC, or of the dedicated software program or mobile phone.

For the IP and DDNS address settings, refer to Network Setup on page 77.

If the MAC address of the DVR is 00-11-5F-12-34-56 and the web port number is 8080,
enter http://00115f123456.dvr1ink.net:8080 in the address bar of the web
browser.

If you have renamed DDNS as mydvr, you can make network connection at
http://mydvr.dvrlink.net:8080.
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Monitoring

Getting Started

Logging In

1. Connect the adapter to the 12V power input port in the rear panel of the DVR.

2. Turn on the power switch in the rear panel of DVR. With a beep, the logo screen appears
several seconds after the front LED turns on.

3. When the booting process is completed, the live screen with the login screen appears.

To manipulate or access the menus of DVR, you will need to log in.

1.  When the system starts, the login screen appears (see Figure 3-1).

Figure 3-1 Log In Screen

LOG IN

USER ID ADMIN >

EIEEICE
5 i e -
6 0 | =
010 S R e [ s |

2. Select a user with the drop-down list and provide the password.
The default password of the ADMIN account is 1234.

3. Click OK. If the login information is correct and valid, you will see the live screen (see
Figure 3-4).

PASSWORD

FIEIEEEEEE]

CAUTION For security purposes, change the password before
you use the product for the first time after purchasing it.
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Logging Out

To prevent unauthorized access, it is recommended to log out when you leave the monitoring
station.

Note  Hover the cursor near the bottom of the screen to display the menu.

1. In the monitoring screen, click MENU in the bottom left corner of the screen (see
Figure 3-2), then select to LOG OUT, or press the LOGOUT button on the remote control.

Figure 3-2  Selecting Log Out from Menu

SEARCH
ARCHIVING

SYSTEM SETUP
RECORD SETUP

uTt
SHUTDOWN

= 07-23-2013
o [l BR R EE G E& QA HE © o B g i 00w

2.  While logged out, the Search / Backup / System Settings / Record Settings / Exit menus
are restricted to use.

System Shutdown

1. In the monitoring screen, click MENU in the bottom left corner of the screen (see
Figure 3-2), then select to SHUTDOWN the system, or press the POWER button on the
remote control.

Figure 3-3  Shutdown Screen

SHUTDOWN
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PASSWORD
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2. Use the virtual keyboard to enter the password, then click OK (see Figure 3-3).

CAUTION Be sure to use this procedure to shut down the
systems. If you turn off the system in an abnormal manner such as
removing the power cord while the system is in operation, the disk will
have or will increase the bad sectors, causing data loss and shortened
life cycle of the disk.

Live Screen at a Glance

The live screen largely consists of three components: video window, status bar and timeline
zone (see Figure 3-4).

Figure 3-4  Live Screen

/—Video window yau Quick menu Time line
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Video Window

Table 3-1 describes the icons that are used in the video window.

Table 3-1 Video Window Icons

ltem Description
Camera ID CAM41 shows the camera ID.
I:l Displayed if an event recording is reserved.
c Display the status of the continuous recording.
Record Mode A Display the recording status when an alarm occurs.
Icons
M Display the recording status when a motion event occurs.
E?) Display the status of the emergency recording.
Audio 1/O Icons «. The audio signal of the connected camera is outputting.

A motion is detected by the connected camera.

Motion Detection Z?'
Icon

Status Bar

Figure 3-5 The Status Bar

. : - I 07-23-2013
MENU ADMIN :-: .E=== H E @ ®\ E o) e A ‘ O 59.03:58 AM

Press the ¥ button on the remote control, or place the mouse in the lower area of the screen to
display the status bar.

Table 3-2 Status Bar Descriptions

Item Description
Select one of the System setup, Search and Backup menu items to
Menu Button MENU
access them.
User ID ADMIN Show the ID of the user who is currently logged in.
! Edit the screen layout to show video in full screen mode, or to show the
video along with the status bar and timeline.

Use these icons to select the split screen mode to view video with
(choose from single, quad, 9-panel or 16-panel screens).

Screen Control

Buttons Select Auto Sequence Mode. When a user arranges channels on
desired tiles on a split screen view, this setting is listed for later selection.
Selecting a screen setup directly switches the screen mode as

configured.
@ Display or hide the on-screen display (OSD) menus on the screen.
PTZ Go to the P_TZ screen. You can control the PTZ operations of a
PTZ-compliant camera on the PTZ screen.
Zoom Q Zoom in or out on the selected video image.
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Table 3-2 Status Bar Descriptions (cont’d)
ltem Description
Quick Log Display the log list of recent recording events.
Audio Channel . . . .
Selection Button You can use the camera supporting the audio input to listen to the audio.
Panic Record ® Start the emergency recording.
Alarm Indicator Blinks when an event occurs. It will not blink if no action to the event has
— been set. Click to view information about the event that occurred.
Check if the network connection is made through an external PC or
Network s ; ; . ; : .
. B mobile device. Click this to view the details of the concurrent users and
Connection Status .
to check the network connection status.
Show the disk space information. If you have set the disk to overwrite
Disk Space mode, it will be displayed "OW" (Over Write) from the starting point of the
overwriting.
. 07-23-2013 .
Date and Time oy an Shows the current date and time.

Timeline

Press the P> button on the remote control or move the cursor to the right of the screen to display
the timeline (Table 3-3 describes timeline elements and buttons).

Double-click the timeline to move to the video screen. Drag and drop it to make a backup or
event search for the specified area.

Table 3-3 Timeline Element Descriptions
Item Description
Timeline Display the date of the current timeline. Click this button to select
Date a different date for the timeline.

Zoom in/out of
Timeline

Q@&

Expand or collapse the timeline.

Navigation
through Timeline

Move to the previous or next point of time in the timeline. You can
also use the mouse wheel to navigate through the timeline.

Timeline Bar

Represents the recorded data. The color of each bar indicates:
* Green: Continuous Recording

* Red: Alarm Recording

* Blue: Motion Recording

* Yellow: Panic Recording
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Quick Menu

Right click on a channel to display a quick menu popup window (see Figure 3-4). describes the
quick menu commands.

Table 3-4 Quick Menu Descriptions

ltem Description

Channel Number Display the number of the currently displayed channel.

Play Start playing the video of the selected channel from the specified time.
Zoom Operates digital zooming on the selected channel.

Snapshot Capture Capture the current live video and save it in the JPEG format.

Note After capturing the image, you can save it to the hard drive or
export it to an external USB memory device.

Using the Status Bar in Live Mode

Selecting a Split Screen Mode

screen options. Alternatively, press the DISPLAY button on

Click a desired split mode from 1-, 4-, 9- and 16-panel split . E
the remote control until a desired split mode is displayed.

Selecting an Auto Sequence Mode

Click the Sequence button in the status bar (see Figure 3-6), or press the SEQ button on the
remote control to perform the specified sequence mode.

Figure 3-6  Selecting an Auto Sequence

MENU ADMIN

You can configure the sequence settings in the SEQUENCE menu. For more information, refer
to Sequence Settings on page 66.

Controlling a PTZ Camera

You can control PTZ cameras connected to each channel. Use the mouse to click PTZ button
on the status bar ( ), or press the PTZ button on the remote control to initiate the predefined
sequence.

www.honeywell.com/security



Monitoring | 49

In PTZ mode, use buttons on the screen to control PTZ movement, or use the ZOOM, FOCUS
and PRESET buttons on the remote control to control the PTZ.

Figure 3-7 PTZ Mode Controls On Screen

CH CH1 -CAM1 -

rlFﬂESET

NO. NAME

Select a

Preset \

JLARM IN (DVR} 1425354
FOCUS . ADNEM OUT (DVR) 1%(2)

Z00M

RIS

SCAN/TOUR ¥ Move ¥ Zoom / Focus / ¥ Record / Screen
Settings PTZ Iris Adjustment Control / Zoom

Digital Zooming

You can enlarge the monitoring screen for a better view. Zooming will enlarge the video of the
selected channel. If no channel is selected, channel 1 will be zoomed.

1. Click Zoom ( @) in the status bar, or move the cursor to a desired channel and right-click
it to display the context menu and select ZOOM. Alternatively, you can press the ZOOM
button on the remote control.

Figure 3-8 Zoom Control Screen

W
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2. The zoom control screen opens (see Figure 3-8). When the menu bar appears in the
bottom right of the screen, use these buttons to control the zooming:

. : Select a channel to zoom in/out.
+ BB : Zoom out of the current (enlarged) image step by step.
. : Enlarge the current image step by step.

e Zoom Box: Use the video insert in the yellow box to move to or select a desired
zooming area.

. : Exit the zooming screen and return to the live screen.

Note  Digital zooming magnifies the video image digitally and produces
enlarged images that may not be as sharp and clear after enlarging.
For sharper and clearer magnification, it is recommended to use
cameras that support optical zooming.

Checking the Event Log

You can check the log of the events that occurred.

1. Click Log to display the EVENT LOG window (see Figure 3-9). The log list is sorted with
the latest one on top.

Figure 3-9  Event Log Window
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2. Double-click a desired log to display the event video.

This will open the play screen of the selected log.

Selecting an Audio Input Channel

Select a channel from which the audio signal will be received.
e CHANNEL: Produces the selected channel’s audio, regardless of the split screen mode.

* LINKTO FULL SCREEN: When switching the DVR display mode to view one channel
(Single Split), it produces the selected channel’s audio.
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Figure 3-10 Selecting an Audio Input Channel

AUDIO IN

CHANNEL  |OFF

Note A camera with a supported audio input should be selected. The DVR must be
connected to a speaker to play audio.

Checking the Alarm Status

You can check alarms and events from each camera and the system.

Click OK to close the window.

Figure 3-11 Checking the Alarm Status
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Checking the Network Status
This screen shows the connection status of cameras and network devices.

Click to display detailed information on current users and network connections.

Click OK to close the window.
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Figure 3-12 Checking the Network Status
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Note  For more information, refer to Network Status on page 80.

Checking the Disk Status

You can check status and information of storage devices currently connected to the system.

Click OK to close the window.

Figure 3-13 Checking the Disk Status
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Note For more information, refer to Disk Information on page 88.

Saving Captured Snapshots

You can capture the current video screen and save or export the image to a connected storage
device.

1. Select a channel first, and right click to open the quick menu, and select SNAPSHOT from
the menu, or press the SNAPSHOT button on the remote control.

Figure 3-14 Saving a Snapshot Image
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2. Connect a storage device, and click EXPORT.
To save the captured image onto the built-in HDD, press the RESERVE button.

Note  The saved image can be found in the Archived » Reserved data management
screen and can be backed up at a later time (see Reserved Data Management

on page 131).
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Figure 3-15 Exporting a Snapshot Image
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3. If you selected EXPORT in step 2 above, enter the TAG NAME and MEMO (if needed)
and press BURN or ERASE & BURN (see Figure 3-15). A progress bar appears and
indicates the progress of exporting to the storage device.

*  BURN: Snapshot is stored in the connected USB storage device.

* ERASE & BURN: Deletes all files in the connected USB storage and then saves the
snapshot.

CAUTION Note that ERASE & BURN option erases all data in the
USB storage device and will not be restored once deleted.
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System Setup

Opening the System Setup Menu

Using the Mouse

Q SEARCH
© ARCHIVING
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Using the Remote Control (Method 1)
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Using the Remote Control (Method 2)
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Camera Settings

You can configure the camera settings of: camera title, hidden option, motion and camera type.

Camera Title

You can change the camera ID that is displayed on the screen.
1. From SYSTEM SETUP » CAMERA, select CAMERA TITLE (see Figure 4-1).

2. Usethe A, ¥, €, P, and ENTER buttons on the remote control or use the mouse to
select a channel that you want to rename.

Alternatively, simply double-click the camera to rename from the top left corner.
Figure 4-1  Camera Title Re-Naming

CAMERA

IMAGE SETUP

COVERT SETUP

MOTION SENSOR

PTZSETUP

TAMPER DETECTION

3. Once the virtual keyboard appeared (see Figure 4-2), select desired alphanumeric
characters to complete your input, and press the OK button.

Note  The SHIFT key toggles letter case.

4. To apply the change, click APPLY at the bottom of the screen.
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IMAGE SETUP

COVERT SETUP
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Image Setup

5.
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Figure 4-2  Entering Camera Title with Virtual Keyboard

VIRTUAL KEYBOARD

CAM1
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When done, press EXIT on the remote control or click CLOSE in the lower screen. The
confirmation message appears and you will return to the previous menu.

Note = Camera name allows up to 8 characters in the camera title, combining numbers
and upper/lower case letters.

You can adjust the brightness, contrast, color and quality setting of each channel’s camera (this
option is not available for HD-SDI cameras).

1.

2
3.
4

From SYSTEM SETUP » CAMERA, select IMAGE SETUP (see Figure 4-3).
Use the A, ¥, 4, P, and ENTER buttons on the remote control or mouse to edit settings.
To apply your changes, click APPLY at the bottom of the screen.

Once completed with setup, press EXIT on the remote control or click CLOSE at the
bottom of the screen. A confirmation dialog appears and returns to the previous menu.

Note  Press the PREVIEW button preview your adjustments in the image.
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Figure 4-3 Image Setup Screen

CAMERA

CAMERA TITLE

COLOR — L—- ™ camio
B camil

B cam12

B cAam13

B cAM14

B camis

™ cAamis

PREVIEW
PREVIEW
PREVIEW
PREVIEW
PREVIEW
PREVIEW
PREVIEW

CHANNEL BRIGHTNESS | CONTRAS COLOR

B caMil = PREVIEW

B~ cam2 - PREVIEW

COVERT SETUP B cam3 = PREVIEW
I~ cAM4 a PREVIEW

MOTION SENSOR B~ cAMS = PREVIEW
CHANNEL 1. CAMI Y I cave 3 PREVIEW

PTZSETUP B cam7 = PREVIEW
CONTRAST ™ CAMS = PREVIEW

TAMPER DETECTION HUE __- ™ camg ~ PREVIEW

L L T L L T T [ T T T S L T [ T
L T O L L T T TR TS T TS T TSR TR T 1Y

L L L L L L L L R T 1

@ oA 0

Covert Setup

You can set to hide the camera video so that a specific user or user group can not view it. Set a
channel(s) that you want to hide from a specific user or user group.

1. From SYSTEM SETUP » CAMERA, select COVERT SETUP (see Figure 4-4).

Figure 4-4  Covert Setup Screen
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B cami1s OFF $ OFF : OFF = OFF H
™ CAM16 OFF & OFF & OFF % OFF 3

ADMIN MANAGER USER |
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LOG OuT
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Use the A, ¥, 4, >, and ENTER buttons on the remote control or use the mouse to
select a covert channel(s) from a specific user group.

¢ ADMIN, MANAGER, USER: Set them to ON. The selected channel will be covert from
the applicable user account.

e LOG OUT: Set it to ON. When the user logs out, the current channel will be set to a
covert channel.

*  SHOWN AS: Sets how a COVERT channel will be displayed on the monitor. Select
from:

* No Video: Nothing is displayed on the monitor for the COVERT channel, as if it is
not connected to a camera.

e COVERT: Hides only the live monitoring.
To apply the change, click APPLY at the bottom of the screen.

When done, press EXIT on the remote control or click CLOSE at the bottom of the screen.
The confirmation message appears and you will return to the previous menu.

Set the motion sensor of the camera so that it can detect a motion event.

1.

CAMERA
CAMERA TITLE
IMAGE SETUP

COVERT SETUP

PTZSETUP

TAMPER DETECTION

From SYSTEM SETUP » CAMERA, select MOTION SENSOR (see Figure 4-5).

Figure 4-5 Motion Sensor Screen
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™ CAM16 ON OFF 15 /15 EDIT AREA

CANCEL APPLY

Use the A, ¥, 4, P, and ENTER buttons on the remote control or use the mouse to
specify the use of each option item.

e ACTIVATION: Turn on or off the motion sensor.

* MARK: Set to ON to display the motion detection indicator on each video tile where
applicable.

*  SENSITIVITY: Set the sensitivity level of the motion sensor to either Daytime or
Nighttime.

* EDIT AREA: Specify the motion detection area.
To apply the change, click APPLY at the bottom of the screen.
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4. When done, press EXIT on the remote control or click CLOSE at the bottom of the screen.
The confirmation message appears and you will return to the previous menu.

CAUTION The motion detection sensitivity may differ depending
on the characteristics of the connected camera or the installation
environment.

Setting the Motion Area

From the motion setup window, click EDIT AREA in the right corner to display the area setup
screen. Setting the motion area may differ depending on the camera model. Below is a typical
setting of the motion area.

1. Click EDIT AREA to open the motion area setup screen (see Figure 4-6).

Figure 4-6  Setting a Motion Detection Area
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2. If you are using the remote control, press ENTER to mark the current position.

3. Use the arrow buttons to move to a desired block and press ENTER. The area setup will
begin.

Then, use the arrow buttons to specify the area.

Note  Alternatively, you can use the drag-and-drop method to specify or release the
area as using mouse.

4. If you select the specified area again, it will be released from the selected motion area.

5. Press EXIT on the remote control or right-click any area to display the popup menu as
shown in Figure 4-6.

6. While the popup menu is displayed, select Sensitivity to set the motion detection
sensitivity of the channel currently selected (see Figure 4-7).
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Figure 4-7  Setting Motion Sensitivity
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Use the following options to set up the motion sensitivity:

CHANNEL: Select the channel to set the motion sensitivity on.
DAYTIME: Specify the time period that will be considered as daytime.

SENSITIVITY: 1 (Low) ~ 30 (High). The higher the number is, the more sensitive the
sensitivity level becomes.

DAYTIME: Specify the SENSITIVITY level for the daytime.
NIGHTTIME: Specify the SENSITIVITY level for the nighttime.

Note  Images recorded in a low contrast scene such as at night cause severe

noise, triggering the motion event too often.

If unwanted events occur frequently at night, you may want to reduce
the motion sensitivity for the night duty.

You can configure PTZ cameras connected to each channel. Set the camera ID, protocol, baud
rate and PTZ control speed for each channel.

From SYSTEM SETUP » CAMERA, select PTZ SETUP (see Figure 4-8).

Use the A, ¥, 4, P, and ENTER buttons on the remote control or mouse to set protocol
and bitrate of each channel.

1.
2.

Note Refer to the PTZ camera’s user guide, or consult a camera installation service

provider for further details on setting up the PTZ camera, such as camera
address, protocol and baud rate.
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Figure 4-8 PTZ Camera Setup Screen
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To apply the change, click APPLY at the bottom of the screen.

When the setup is completed, press EXIT on the remote control or click CLOSE at the
bottom of the screen to display a confirmation dialog.

Click CANCEL to return to the previous menu.

Tamper Detection

You can set the DVR to detect tampering (attempt to interfere monitoring operations by
tampering with an installed camera).

1. From SYSTEM SETUP » CAMERA, select TAMPER DETECTION (see Figure 4-9).

2. Usethe A, ¥, «, P, and ENTER buttons on the remote control or mouse to select the
ACTIVATION drop-down list for the camera to turn tamper detection for that camera ON
or OFF.

3. Usethe A, ¥, «, P, and ENTER buttons on the remote control or mouse to select the
MARK drop-down list for the camera to program tamper detection for.

MARK turns the detection indicator to be displayed onscreen ON or OFF.

www.honeywell.com/security



System Setup | 63

Figure 4-9 Tamper Detection Screen
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4. Select SENSITIVITY to open the sensitivity options for the camera (see Figure 4-10). Enter
the SENSITIVITY values in the window that opens:

e SENSITIVITY LEVEL: This specification can be set separately for Day and Night
modes. This value sets the detection sensor’s sensitivity for each detection block.

*  DAYTIME: If the sensitivity value will be different for day and night times, specify the
time period that will be considered day time in the DAYTIME fields.

Figure 4-10 Tamper Detection Sensitivity
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CANCEL APPLY

5. To apply the change, click APPLY at the bottom of the screen.

6. When done, press EXIT on the remote control or click CLOSE at the bottom of the screen.
The confirmation message appears and you will return to the previous menu.
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Display Setting

You

OSD Settings

You

can configure screen display setup for On-screen Display, Screen Layout, Sequence.

can set Camera Name, Icon, Status Bar, Timeline, Borderline, User Name and Language

options.

1.

From SYSTEM SETUP » DISPLAY, select OSD (see Figure 4-11).

Use the A, ¥, 4, P, and ENTER buttons on the remote control or mouse to set each
option of the OSD item.

Figure 4-11 OSD Options Screen

@ A
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Set the following OSD options:

CAMERA TITLE: Specify the display of the camera title on the screen.

RECORDING MODE ICON: Specify the display of the record mode icon on the
screen.

STATUS BAR ON FULL SCREEN MODE: Select to show or hide the status bar in full
screen mode.

* AUTO HIDE: Place the cursor in the lower area of the screen to display the status
bar. If moving the cursor up, the status bar will disappear.

* ALWAYS ON: The status bar will be displayed at all times.

¢ 5 SEC ~1 MIN: If no mouse movement is detected for from 5 seconds to 1
minute, the status bar will disappear.

TIMELINE ON FULL SCREEN MODE: Select to show or hide the timeline in full
screen mode.

e AUTO HIDE: Place the cursor in the right corner to display the timeline. If moving
the cursor to the left, the timeline will disappear.

e ALWAYS ON: The timeline will be displayed at all times.
e ALWAYS OFF: The timeline will not be displayed.

BORDER LINE: Specify the display of the cross-border between channels in a split
mode.

BORDER COLOR: Select a color for the border.
USER NAME: Specify the display of the currently logged-in users on the status bar.
LANGUAGE: Select a menu display language.

To apply the change, click APPLY at the bottom of the screen.

When done, press EXIT on the remote control or click CLOSE at the bottom of the screen.
The confirmation message appears and you will return to the previous menu.

Monitor Settings

If you change from monitoring mode to sequence, you will have to set the interval of the
sequence.

1. From SYSTEM SETUP » DISPLAY, select MONITOR (see Figure 4-12).
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DISPLAY

Figure 4-12 Monitor Options Screen

SEQUENCE DWELL 55EC

MONITOR SPOT DWELL 5SEC

SEQUENCE

Usethe A, ¥, 4, P, and ENTER buttons on the remote control or mouse to set the dwell
for Sequence mode and SPOT Out dwell.

* SEQUENCE DWELL: Sets the time interval to the next screen mode for Live
monitoring, which defines individual screen mode’s dwell time in the Sequence. (Can
setto 1 sec ~ 60 sec).

* SPOT DWELL: Sets the time interval to the next view type, which defines individual
view type’s dwell time for SPOT OUT. (Can set to 1 sec ~ 60 sec).

To apply the change, click APPLY at the bottom of the screen.

When done, press EXIT on the remote control or click CLOSE at the bottom of the screen.
The confirmation message appears and you will return to the previous menu.

Sequence Settings

Select a split mode for the sequence, and also select a list of active items when the sequence
is performed.

1.
2.

From SYSTEM SETUP » DISPLAY, select SEQUENCE (see Figure 4-13).

Use the A, ¥, 4, >, and ENTER buttons on the remote control or mouse to add a
sequence or change the settings of the existing sequence.

* ACTIVATION: Select a list that you want to activate the sequence for. Only one list will
become active.

 ADD: Add a sequence.
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Figure 4-13 Sequence Options Screen
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3. To apply the change, click APPLY at the bottom of the screen.

4. When done, press EXIT on the remote control or click CLOSE at the bottom of the screen.
The confirmation message appears and you will return to the previous menu.

Adding a Sequence

1. Click ADD in the bottom of the screen.

2. When the ADD dialog appears (see Figure 4-14), enter a SEQUENCE TITLE using the
virtual keyboard.

Figure 4-14 Adding a Sequence Screen
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3. Enter the name of the sequence and click SAVE.
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DISPLAY

SEQUENCE

SPOT OUT

When the ADD VIEW TYPE dialog appears, click ADD.

When the SEQUENCE SETUP dialog appears. From the VIEW TYPE area, select a split
mode that you want to add.

Figure 4-15 Sequence Setup Screen
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The selected split mode is displayed in the VIEW CONFIGURE area of the screen. Select
a channel you want to display in each channel of the split screen layout.
Click CONFIRM.

The set sequence mode is confirmed and will be added to the Add Sequence list in the
order it was added.

When finished with the sequence, click CLOSE at the bottom of the screen.
After the sequence type is saved, you will return to the previous screen.

Place your mouse cursor over a desired tile of added Sequence, right click on it or press
the ENTER button on the remote control to edit or delete the sequence.

Editing a Sequence

1.
2.
3.

Select a sequence that you want to edit in the list.
The EDIT dialog appears (see Figure 4-16).

Use the A, ¥, 4, >, and ENTER buttons on the remote control or use the mouse to edit
the selected sequence.

* SEQUENCE TITLE: enter a new sequence name.

* ACTIVATION: specify the use of the sequence.

* MODIFY: change the settings of the sequence mode.
e DELETE: delete the selected sequence list.

e CANCEL: cancel the changes.
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Figure 4-16 Editing a Sequence
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4. Pressing the MODIFY button will display the Edit Sequence window (see Figure 4-17).
Figure 4-17 Edit Sequence Window
DISPLAY
05D
MONITOR
SPOT OUT
5. To change the existing settings, select a screen mode that you want to edit and right-click
to display the context menu. Then, select MODIFY from the menu.
6. When you are finished editing, click CLOSE to close the window.

To apply your changes, click APPLY at the bottom of the screen.

800-15802 - A - 12/2013



70 | Performance Series HREP2 DVR User Guide

Spot Out Settings

Apart from the main screen display, you can configure the Spot Out to display a Live channel
as needed in various live view types.

You can set the live view type of display output through the SPOT terminal and activate /
deactivate it.

1. From SYSTEM SETUP » DISPLAY, select SPOT OUT (see Figure 4-18).

Figure 4-18 Spot Out Options Screen
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2. Usethe A, ¥V, <4 P, and ENTER buttons on the remote control or mouse to edit Spot
Out properties.

e SPOT TITLE: Name the Spot Out setup.
* ACTIVATION: Set whether to activate / deactivate the spot out setup.
* MODIFY: Edit the view type of the spot output.
* SAVE: Save the changes of spot output settings.
3. To apply your changes, click APPLY at the bottom of the screen.

4. Once completed with setup, press the EXIT button on the remote control or click CLOSE
at the bottom of the screen. A confirmation dialog appears and returns to the previous
menu.

Adding a View Type to a Spot Output

1. Select an item from the SPOT Output list to be changed.

2. The MODIFY window appears. Click MODIFY.

3. When the View Type selection window appears, click ADD VIEW TYPE.
4. Select the desired View Type and configuration, and click CONFIRM.
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Figure 4-19 Spot Setup Screen
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5. Complete adding and click CLOSE to close the edit window.

Editing/Deleting a View Type of Spot Output
1. Select an item from the SPOT Output list to be changed.
2. The MODIFY window appears. Click MODIFY (see Figure 4-20).

Figure 4-20 Modifying a Spot Output View Type
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3. When the View Type selection window appears, select the desired View Type to be edited
or deleted, and press the ENTER button on the remote control or right click on it.

* MODIFY: Displays SPOT SETUP window for editing View Type and other properties.
e DELETE: Deletes the selected View Type.

4. Complete editing and click CLOSE to close the edit window.

Audio Setup

You can configure audio related settings (channel and network transfer) and signal beep for
remote control operations.

Audio Options

Choose whether to receive the live sound source and select an audio channel.
1. From SYSTEM SETUP » AUDIO, select AUDIO (see Figure 4-21).

Figure 4-21 Audio Setup Options

AUDIO
DEFAULT LIVE AUDIO CHANNEL OFF
BUZZER NETWORK AUDIO TRANSMISSION ON
RECEIVE NETWORK AUDIO ON

2. Usethe A, ¥, 4, P, and ENTER buttons on the remote control or use the mouse to
select an item that you want to edit.

e DEFAULT LIVE AUDIO CHANNEL.: select an audio channel to monitor on the live
screen.

* NETWORK AUDIO TRANSMISSION: decide if the DVR transfers the audio signal to
the remote client. DVR » PC (Remote Client).

* RECEIVE NETWORK AUDIO: decide if DVR receives the audio signal from the
remote client. PC (Remote Client) » DVR.
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3. To apply the change, click APPLY at the bottom of the screen.

4. When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Buzzer Options

You can set to output the buzzer if you manipulate the remote control.
1. From SYSTEM SETUP » AUDIO, select BUZZER (see Figure 4-22).

Figure 4-22 Buzzer Options Screen

AUDIO

BUZZER

REMOTE CONTROLLER BEEP ON

2. Usethe A, ¥, 4, P, and ENTER buttons on the remote control or use the mouse to
select an item that you want to edit.

REMOTE CONTROLLER: specify the output of a beep when you press a button on the
remote control.

To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

User Settings

You can configure the settings regarding user management and user and group permissions.
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User Management Options

You can add a user account(s) that can be edited at a later time.
1. From SYSTEM SETUP » USER, select MANAGEMENT (see Figure 4-23).

Figure 4-23 User Management Options

USER

ADMIN ADMIN

(oo

2. Usethe A, ¥, 4, P, and ENTER buttons on the remote control or use the mouse to add
a user account or select an item that you want to edit.

To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Adding a User Account

1. Click ADD at the bottom of the User Management screen (see Figure 4-24).

2. Usethe A, ¥, 4, and P buttons on the remote control and move to a desired item. Then,
press ENTER to select the item.

USER ID: Enter the user ID using the virtual keyboard.
PASSWORD: With the virtual keyboard, enter the password.

GROUP: From ADMIN, MANAGER and USER, select a group that the user belongs
to.

EMAIL: Type in the e-mail address to which you will receive notification of an event if
it occurs.

EMAIL NOTIFY: Choose whether you will receive notification of an event if it occurs.

Note  To use EMAIL NOTIFY, a sendmail server and its port should be previously

configured.
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* COVERT CHANNEL: You can set the channel to hide from a specific user.

75

Note = The COVERT CHANNEL option hides the video of the selected channel from
being displayed on the screen.

Figure 4-24 Adding a User
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3. When finished, click OK. The new user account will be listed.

Editing a User Account

1.  From the list of users, select a user account to edit and click EDIT next to it.

2.  From the Edit window (see Figure 4-25), make necessary changes and click OK.

Note = The ADMIN account can not be changed or edited.
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Figure 4-25 Editing a User Account
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3. To delete the user account, click DELETE.

Group Authority Settings

You can grant different user groups different permissions to a specific menu screen.
1. From SYSTEM SETUP » USER, select GROUP AUTHORITY (see Figure 4-25).

Figure 4-26 Group Authority Settings Screen
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Use the A, ¥, 4, P>, and ENTER buttons on the remote control or use the mouse to set
the permissions for both MANAGER and USER groups.

e SEARCH: Set the access permissions for the Search menu.

* ARCHIVING: Set the access permissions for the Backup menu.

e SYSTEM SETUP: Set the access permissions for the System Setup menu.
« RECORD SETUP: Set the access permissions for the Record Setup menu.

e EVENT ACTION CONTROL: Set the permissions to output the alarm or control the
buzzer if an event such as an alarm occurs.

e LISTEN TO AUDIO: Set the permission to listen to the audio.
* REMOTE LOG IN: Set the permission to access remotely.
e SHUTDOWN: Set the permission to shut down the DVR from the System menu.

Note  The ADMIN account is the master account and is allowed for all permissions. The
ADMIN account can not be edited for individual permissions.

To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Network Setup

You can set IP address, DDNS and E-mail settings, and check network status.

IP Setup

Edits IP address related properties and the remote service port of the DVR.

1.
2.

From SYSTEM SETUP » NETWORK, select IP SETUP (see Figure 4-27).

Usethe A, ¥, 4, », and ENTER buttons on the remote control or use the mouse to
specify each item of the network settings.

DHCP: If it is checked, set the IP address of the DVR to Dynamic IP.

Note For DHCP address allocation, the DVR should be connected to a
network environment, such as a router, that provides with DHCP server
service.

Simple network hubs may have no DHCP server.
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Figure 4-27 IP Setup Screen
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3. Deselect the DHCP option to enable manual static IP address configuration.
* |IP ADDRESS: Provide the IP address.
e GATEWAY: Provide the gateway address.
e SUBNET MASK: Provide the subnet mask address.
* 1ST DNS SERVER: Enter the address of the primary DNS server.
e 2ST DNS SERVER: Enter the address of the secondary DNS server.

¢ RTSP SERVICE PORT: Port number that the remote client receives the DVR video
from.

* WEB SERVICE PORT: Port number used for connecting to the DVR with the web
browser.

* PORT FORWARDING: If you are using a router, you can set the port forwarding so
that external access to the DVR is enabled.

If the router does not support the uPnP protocol, you must set the port forwarding
manually. For more information, contact your network administrator.

* DELETE PORT: Release the port forwarding settings for the router.
¢ MAX TX SPEED: Limit the network transfer rate to access a remote client.

The video signal may be transferred at a less rate than specified, which depends on
the status of your network connection.

To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

DDNS Settings

You can configure the DDNS settings so that remote users who are connected to the network
can access remotely.
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Note DDNS is an IP redirection service in a dynamic IP environment that redirects

(maps) the new IP address to a registered domain name each time the IP
address is changed.

1. From SYSTEM SETUP » NETWORK, select DDNS (see Figure 4-28).

Figure 4-28 DDNS Settings Screen
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DVR ADDRESS ;

2. Usethe A, ¥, €, P, and ENTER buttons on the remote control or use the mouse to
specify the use of DDNS and select a server.

DDNS: Specify the use of DDNS connection.
DDNS SERVER: Select a server to connect to.
DVR NAME: Enter the name of the DVR that you want to use as DDNS.

DDNS REGISTRATION TEST: Check if the DVR NAME can be set as DDNS. If there
is a duplicate name in the server, the registration will fail. If this is the case, rename the
DVR NAME and press Test to check if it works properly.

DVR ADDRESS: Provide the DVR NAME and press the DDNS REGISTRATION
TEST button. The name will be added automatically.

DDNS CONNECTION TEST: Perform the connection test to check if DDNS is
normally registered.

3. To apply the change, click APPLY at the bottom of the screen.

Email Settings

You can register and test an email address so that an email notification is delivered at a specific
interval or if an event occurs.

1. From SYSTEM SETUP » NETWORK, select EMAIL (see Figure 4-29).
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NETWORK
P SETUP

EMAIL

Network Status

Figure 4-29 Email Settings Screen

SERVER
PORT 25
SECURITY OFF

USER
PASSWORD
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Usethe A, ¥, 4, », and ENTER buttons on the remote control or use the mouse to
specify the use of email and select a server.

* SERVER: Set up the mail server. Set the mail server that will be used for notification to
the DVR. Use the virtual keyboard to enter your mail server.

* PORT: Enter the mail server port.

e SECURITY: Ifit is set to ON, the email will be transferred in secure mode. If it is set to
OFF, the email will be transferred to a server that does not support SSL.

e USER: Provide the email account (ID) of the sender.

* PASSWORD: Provide the password of the sender.

* TEST EMAIL ADDRESS: Enter an email address for the test purpose.

e TEST: Send a test email and check if the test email is delivered normally.
To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

From the network map screen, you can check the Internet connection status and camera
connection status, and check also the details of the connection status for each camera.

1.
2.

From SYSTEM SETUP » NETWORK, select NETWORK STATUS (see Figure 4-30).

Use the A, ¥, €, P>, and ENTER buttons on the remote control or use the mouse to
select one between NETWORK MAP and DETAIL STATUS.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

www.honeywell.com/security



System Setup | 81

Figure 4-30 Network Status Screen
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Network Map

* |IP ADDRESS: Indicates the internal IP address of the DVR.

« MAC ADDRESS: Indicates the internal MAC address of the DVR.

* DDNS ADDRESS: Indicates the internal DDNS address of the DVR.

* RTSP SERVICE PORT: Indicates the network port of the video service.
For remote service, the router must have set up the port forwarding.

* WEB SERVICE PORT: Indicates the web service network port.

For the remote service to be enabled, the corresponding port of the router should have set
up the port forwarding.

* DDNS UPDATE STATUS: Shows if the DDNS address was registered to the DDNS server
normally. Press [[8}§ to try to register the DDNS address forcibly.

e EXTERNAL IP ADDRESS: Indicate the IP address for the Internet, accessible from the
DVR.

The DVR can be granted access with the web browser at http://<External IP
Address>:<Web Service Port>.

The IP address can vary in a dynamic IP environment.
* CONNECTED CLIENTS: Shows the list of clients that are currently connected.

Press 4 to forcibly terminate the connection of an unwanted client.

Note  Termination is limited to only users in a lower group than the current user.
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System Settings

You can configure the settings for date/time, system management, and keyboard controller.

Date/Time Settings

Specify the current date and time.
1. From SYSTEM SETUP » SYSTEM, select DATE/TIME (see Figure 4-31).

Figure 4-31 Date/Time Settings Screen

SYSTEM

DATE/TIME 07-23-2013 10:25:48 AM ®

SYSTEM MANAGEMENT

k ki DATE FORMAT MM/DDAYYYY =

TIME FORMAT AM / PM =

SYSTEM INFORMATIO

CONTROL DEVICE o NETWORK TIME SYNCHRONIZATION
TIME SERVER pool.ntp.org
AUTO TIME SYNC OFF =
SYNC AT 00:00 - i

«TIMEZONE / DST

TIMEZONE GMT+00:00 Europe/London -
DST ON -

2. Usethe A, ¥, €, P, and ENTER buttons on the remote control or use the mouse to
change the time or set the options as necessary.

e DATE/TIME: Set the current time and date.

Click to adjust the time manually (see Figure 4-32).
* DATE FORMAT: Specify the date format.
¢ TIME FORMAT: Specify the time format.

«  TIME SERVER: Obtain the current time from the time server. Click @) to get the
current time.

e AUTO TIME SYNC: Automatically synchronize the time with the time server at a
specific time.

e SYNC AT: Set the time to sync with the time server.
* TIMEZONE: Specify the GMT standard time for your local area.
e DST: You can set up or release the DST (Daylight Saving Time).
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Figure 4-32 Date/Time Manual Setting

SYSTEM
DATE / TIME #TIME SETTING
DATE/TIME 07-23-2013 10:25:51 AM
SYSTEM MANAGEMENT
DATE FORMAT MM/DD/YYYY
TIME FORMAT AM / PM
SYSTEM INFORMATION
CONTROL DEVICE »NETWORK TIME SYNCHRONIZATION
TIME SERVER pool.ntp.org
AUTO TIME SYNC OFF
SYNC AT 00:00

«TIMEZONE / D5ST
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DATE/TIME
YEAR MON DAY HOUR MIN SEC
S S S
2013 07 |23 10 25 48
i il i il s sd

-
>

TIMEZONE GMT+00:00 Europe/London -
DsT ON -
I T |
Note  Both TIME SERVER and TIME SYNC will be enabled only if the DVR is

connected to the Internet.

3. To apply the change, click APPLY at the bottom of the screen.

4. When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous

menu.

System Management Settings

You can check, update or reset the system information.
1. From SYSTEM SETUP » SYSTEM, select SYSTEM MANAGEMENT (see Figure 4-33).
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Figure 4-33 System Management Screen

SYSTEM
DATE / TIME
SYSTEM INFORMATION
CONTROL DEVICE
2. Usethe A, ¥, «, P, and ENTER buttons on the remote control or use the mouse to set
each option of the system management.
* FW UPDATE: You can update the current software with the latest version (see
Figure 4-34).
Figure 4-34 System Management Upgrading Firmware
SYSTEM
DATE / TIME

SYSTEM INFORMATION
FW UPGRADE

CONTROL DEVICE

*«  FACTORY DEFAULT: Return the DVR settings to the factory default.
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CAUTION If you proceed with the firmware upgrade or select to
reset to the factory default, all current settings of the DVR will be erased.
In such a case, you must configure the network, time and recording
settings again.

* SYSTEM DATA: Save the system settings or get the system information from another
device.

e SAVE: Store the DVR settings to a storage device. Connect the storage device to
the USB port of DVR.

* LOAD: Apply the settings of the storage device to the DVR. Connect the storage
device to the DVR USB port (see Figure 4-35).

Figure 4-35 System Management Loading System Data

SYSTEM

DATE / TIME #SYSTEM MANAGEMENT

FACTORY DEFAULT W

SISTENE IHFORKAATION SYSTEM DATA
. . LOAD SYSTEM DATA

I SYSTEM ID
CONTROL DEVICE DEVICE USB Flash Disk X
PASSWORD

FILE NAME
EXPIRED TERM OF PASSWORD

AUTO LOGOUT
WAIT TIME l il o

* PASSWORD: Open or close the dialog box for settings of the menus: quit, system
settings, record settings, backup, and search.

CAUTION If it is set to Off, note that the ADMIN account is only
effective and access to all menus will be restricted.

* EXPIRED TERM OF PASSWORD: You will be prompted to change the current
password after a certain period of time.

* AUTO LOGOUT: If there is no user input for a certain period of time, you can set to
log out automatically.

e WAIT TIME: Specify the waiting time for Auto Logout.

3.  When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen to return to the previous menu.

Upgrading Firmware
1. Connect the USB storage device that contains the upgrade files to the DVR.
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2. Click USB. The FW UPGRADE dialog opens (see Figure 4-36).

Figure 4-36 FW Upgrade Dialog

FW UPGRADE
DEVICE USB Flash Disk -
F/W LIST 31310.1.700001.18.nbn

Select an upgrade file from the files in listed in the F/W LIST.

Click UPGRADE.
When the confirmation message appears (see Figure 4-37), click OK.

Figure 4-37 Confirming Firmware Upgrade

FW UPGRADE
CONFIRM

(@)

Do you want to upgrade firmware?

6. The progress bar displays the progress of the firmware upgrade process (see
Figure 4-38).

Figure 4-38 Firmware Upgrade Progress Bar

FW UPGRADE
DEVICE USB Flash Disk -
v

F/W UPGRADE il

UPGRADE CLOSE

7. When the upgrade is complete, reboot the system.

CAUTION If the DVR is forcibly turned off while the firmware
upgrade is in progress, this can cause a serious damage to the DVR.

System Information

You can check the current system version and system-related settings.
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1. From SYSTEM SETUP » SYSTEM, select SYSTEM INFORMATION (see Figure 4-39).
Figure 4-39 System Information Screen

SYSTEM

DATE / TIME #SYSTEM INFORMATION

FW VERSION

LAST FW UPDATE DATE
HW VERSION

DISK CAPACITY
DISK USAGE
NUMBER OF DISKS
IP ADDRESS

MAC ADDRESS
DDNS ADDRESS
RTSP SERVICE PORT
WEB SERVICE PORT
RESOLUTION
SYSTEM 1D

SYSTEM MANAGEMENT

CONTROL DEVICE

#STATUS

CAMERA CONNECTION 1T2]374]15]6]7]18]C

ALARM IN (DVR) (02)3X4)

ALARM OUT (DVR) @@

I I B
Check the status of the current system.

3.  When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Control Device Settings

Configure the settings of the remote control and keyboard controller.

Note  This function is provided for controlling individual DVR separately using a control
device or remote control, in case the site has multiple DVRs of the same model.

1. From SYSTEM SETUP » SYSTEM, select CONTROL DEVICE (see Figure 4-40).

2. Usethe A, ¥, 4, P, and ENTER buttons on the remote control or use the mouse to set
the connection options for the control device.
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Figure 4-40 Control Device Settings

SYSTEM

ME «CONTROL DEVICE
SYSTEM ID PROTOCOL BALD RATE

SYSTEM MANAGEMENT
& : DEVICE 0 s D-Max = 9600

«REMOTE CONTROLLER

CONTROL DEVICE

REMOTE CONTROLLER ID 0

* SYSTEM ID: Set the ID of the DVR so that the keyboard controller can identify.
* PROTOCOL: Set up the protocol of the keyboard controller.

* BAUD RATE: Specify the RS485 communication speed.

*  REMOTE CONTROLLER ID: Set the ID of the remote control.

To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Storage Settings

You can configure the settings of and view information of the disk and external storage device.

Disk Information

This screen will show information about the connected disk.
1. From SYSTEM SETUP » STORAGE, select DISK INFORMATION.

2. Usethe A, ¥, 4, P, and ENTER buttons on the remote control or use the mouse to
select either INTERNAL (see Figure 4-41) or EXTERNAL STORAGE (see Figure 4-42).

Please check the status for each connected device.
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Figure 4-41 Disk Information for Internal Disks

DISK OPERATIONS

SMART, SETUP

oo I

Figure 4-42 Disk Information for External Storage

DISK OPERATIONS

SMART, SETUP

oo I

e START /END TIME: Show the start time and end time of data stored in each disk.

* STATUS: Check if the connected disk is being used by the DVR. If you encounter a
problem with the disk, the DVR will terminate the connection to the disk and mark it as
Not In Use.

* CAPACITY: Show the capacity of the disk.
¢ MODEL: Indicate the disk model.
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e S.M.A.R.T STATUS: Read the S.M.A.R.T information of the disk and check to display
if the current disk is in normal operation.

¢ NORMAL: The disk is in a normal state.

* CHECK: The disk has an error so that you need to check the disk or the
connection cables of the disk.

If you leave the problem unresolved, no recording may be enabled. So it is
recommended that you replace the disk immediately.

* ERROR: The disk fails or is unable to use due to an error of the disk or the cable.
The disk should be replaced immediately. Contact the retailer or the customer
service to replace the disk.

3. When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen to return to the previous menu.

Disk Operations

You can set to delete the recording automatically and set the overwrite options, and you can
also format the HDD recording data.

1. From SYSTEM SETUP » STORAGE, select DISK OPERATIONS (see Figure 4-43).
Figure 4-43 Disk Operations Screen

STORAGE

FORMATION
DISK WRITE MODE OVERWRITE s

RECOROING TIME LT o -

SMART.SETUP DISK FORMAT

aos
2. Usethe A, ¥, 4, P, and ENTER buttons on the remote control or use the mouse to set
the operation conditions of the disk.
* DISK WRITE MODE: Specify the option for writing to the disk.

e Ifitis set to OVERWRITE, the existing data will be overwritten by new recording
data if the recording data size exceeds the free space of the HDD.

* Ifthe option is set to ONCE and the HDD is full, the DVR will stop recording and
output the beep or alarm that is pre-defined at EVENT.

 RECORDING TIME LIMIT: The recording data will be deleted after a specific time of
reservation. If it is set to OFF, this function will be disabled.

For example: Record Time Limit set to 1 day. Even if there is sufficient free space in
the HDD, it records / keeps videos of the most recent 1 day only.

¢ DISK FORMAT: Format the hard disk.
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CAUTION Note that formatting the HDD will delete all video data
and logs.

To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower

part of the screen. The confirmation message appears and you will return to the previous
menu.

S.M.A.R.T. Settings

You can check the S.M.A.R.T information of the disk and specify the check frequency.

Note What is S.M.A.R.T information?

S.M.A.R.T (Self-Monitoring, Analysis and Report Technology) is to
detect a HDD that is likely to cause a problem in the future with a
warning message.

1. From SYSTEM SETUP » STORAGE, select S.M.A.R.T. SETUP (see Figure 4-44).
Figure 4-44 S.M.A.R.T. Setup Screen

STORAGE

e o
DISK INFORMATION .

DISK OPERATIONS

DISK 1 DISK 3 DISK 4 DISK 5
I f I il

5M.ART. STATUS i I | beraiinro
SMART. CHECK INTERVAL PLE LIRS CHECK NOW

2. Usethe A, ¥, «, P, and ENTER buttons on the remote control or use the mouse to
check the S.M.A.R.T operation and specify the check interval.

* S.M.A.R.T STATUS: Read the S.M.A.R.T information of the disk and check to display
if the current disk is in normal operation.
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Click DETAIL INFO to view the details.

NORMAL: The disk is in a normal state.

CHECK: The disk has an error so that you need to check the disk or the
connection cables of the disk.

If you leave the problem unresolved, no recording may be enabled. So it is
recommended that you replace the disk immediately.

ERROR: The disk fails or is unable to use due to an error of the disk or the cable.
The disk should be replaced immediately.

Contact the retailer or the customer service to replace the disk.

S.M.A.R.T CHECK INTERVAL: Specify the S.M.A.R.T check interval.
Click CHECK NOW to start checking.
To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous

menu.

Event Setup

Define various events, and specify the conditions to notify the user in various ways.

Alarm Out

Specify the alarm output conditions with the work schedule.

Alarm Out
1. From SYSTEM SETUP » EVENT, select ALARM OUT (see Figure 4-45).

2. Usethe A, ¥, «, P, and ENTER buttons on the remote control or use the mouse to
select ALARM OUT and configure the related settings.

NAME: You can rename the alarm.
OPERATION: Set the alarm output mode.

N/O (Normal Open): It normally stays Open. However, if an event occurs, it will
switch to Close.

N/C (Normal Close): It normally stays Close. However, if an event occurs, it will
switch to Open.

DURATION: Specify the duration of the alarm output.

TRANSPARENT: Keep the alarm out for as much time as the event lasts.

UNTIL KEY: Keep the alarm out until a mouse or remote control button is
pressed.

5 ~ 300 SEC: Keep the alarm out for as long as specified.

TEST: Forcibly output the alarm for the test purpose.
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Figure 4-45 Alarm Out Screen

EVENT
[—
EVENT NOTIFICATION
ALARM SENSOR
MOTION SENSOR
VIDEO LDSS
SYSTEM EVENT
TAMPER EVENT
[ omc | v [N
To apply the change, click APPLY at the bottom of the screen.
When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.
ON/OFF Schedule
You can activate or turn off the alarm output as scheduled.
1. Usethe A, ¥, 4, P, and ENTER buttons on the remote control or use the mouse to
select a DATE for the schedule.
Figure 4-46 Alarm Schedule Setup
EVENT

I_ i ..
) iy . CUE

EVENT NOTIFICATION 1 2 |03 | ¢ 1

ey T T O

z = Y ) Y
AN SENSOR i 1 5 O
P e
VIDEO LDSS
SYSTEM EVENT
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2. Drag the mouse to resize the cell or use the on the A, ¥, 4, and P> buttons to move to
the cell, then press ENTER.

3. Select a desired alarm output mode (see Figure 4-46).
e ON: The alarm output is always turned on.
e OFF: The alarm output is always turned off.
* EVENT: Trigger the alarm output in sync with the event.

4. To copy the schedule to another day, click COPY SCHEDULE TO. The Copy Schedule
dialog box opens (see Figure 4-47).

5. Check the checkbox of the date that you want to copy the schedule to (see Figure 4-47).

Figure 4-47 Copying a Schedule

EVENT

ALARM OUT '_ ON/OFF SCHEDULE

EVENT

= W OfF W ON
(o0 01 0 3 [ 04 05| 06 07 08 [08 | 10| 1 | 12 13| 18| 5 | 6 | 17] 38| 39 0] ai 22| 23]

24

COPY SCHEDULE
VIDEO LOSS
ALL
SYSTEM EVENT S SUNDAY
MONDAY
TAMPER EVENT TUESDAY
WEDNESDAY
THURSDAY

FRIDAY

SATURDAY

. T

COPY SCHEDULE TO

6. When finished, click OK to copy the schedule.
7. To apply the change, click APPLY at the bottom of the screen.

8. When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Event Notification

Specify the methods of notification such as buzzer, video popup or email if an event occurs.
1. From SYSTEM SETUP » EVENT, select EVENT NOTIFICATION.

2. Usethe A, ¥, 4, and P> buttons on the remote control or use the mouse to select one
from BUZZER, DISPLAY and EMAIL.

3. Usethe A, ¥, «, P, and ENTER buttons on the remote control or use the mouse to set
the output method and duration.

To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.
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Buzzer Output
You can notify the user of the event using the buzzer (see Figure 4-48).

DURATION:
* TRANSPARENT: Keep the buzzer out for as much time as the event lasts.
* UNTIL KEY: Keep the buzzer out until a mouse or remote control button is pressed.

e 5~ 300 SEC: Keep the buzzer out for as long as specified.

Figure 4-48 Event Notification Buzzer Options

BUZZER

»BUZZER

DURATION 53EC - m

.

Display

If an event occurs, you can display the video screen or a popup message to notify the user of
the event (see Figure 4-49).

VIDEO POPUP: Display the video channel that is synchronized with the event on a single split
screen. Set the DURATION of the single split screen:

* TRANSPARENT: Keep the video popup displayed for as much time as the event
lasts.

¢ UNTIL KEY: Keep the video popup displayed until a mouse or remote control button
is pressed.

* 5~ 300 SEC: Keep the video popup displayed for as long as specified.

Note If multiple events occur at the same time, or if multiple event-related video
channels exist, the video popup will be displayed in the maximum split screen
mode rather than the single split screen mode.
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Figure 4-49 Event Notification Display Options

EVENT

N DISPLAY

& emaL

«VIDEQ POPUP
EVENT NOTIFICATION
DURATION 55EC -

»050 POPUP
DURATION 55EC )

SYSTEM EVENT

OSD POPUP: This will notify the user of the event with a popup message if an OSD popup event
occurs. You can adjust the duration of the popup message:

e  UNTIL KEY: Keep the OSD popup displayed until a mouse or remote control button is
pressed.

* 5~ 300 SEC: Keep the OSD popup displayed for as long as specified.

Email

If an event occurs, this will notify registered users of the event by email. If you do not want to
receive the email, uncheck the EMAIL NOTIFY option in User Management (see User
Management Options on page 74 for more information).

« ADD NEW EMAIL: If you want to add a new mail recipient beside the existing ones, click
this to add the recipient.

*  MINIMUM EMAIL FREQUENCY: Adjust the minimum frequency of sending the email.

For example, even if you have set the minimum frequency to one minute and another
event occurs in less than one minute after the last email sending, the email for the new
event will be sent one minute after.

Note = Some email servers can block the email sending if the email delivery
cycle is too short, and classify it as spam.
Contact your email service provider to adjust the minimum delivery
cycle so that the server does not classify the email as spam.
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Figure 4-50 Event Notification Email Options

VIDED LOSS

SYSTEM EVENT

TAMPER EVENT

Alarm Sensor Settings

You can configure the settings of the alarm sensor and specify the operation of the sensor if an
event occurs.

1. From SYSTEM SETUP » EVENT, select ALARM SENSOR (see Figure 4-51).

Figure 4-51 Alarm Sensor Event Options

VIDED LOSS

SYSTEM EVENT

TAMPER EVENT
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2. Usethe A, ¥, 4, and P> buttons on the remote control or use the mouse to specify the
sensor input method and operation.

* NAME: You can specify the name of the alarm sensor.
* OPERATION: You can specify the type of the alarm sensor.

¢ N/O (Normal Open): Normally the sensor is left Open. If the sensor switches to
Close, an event will be triggered.

* N/C (Normal Close): Normally the sensor is left Close. If the sensor switches to
Open, an event will be triggered.

* LINKED CAMERA: Set the camera to sync with the alarm sensor if it is triggered.

If you have set the alarm recording and the sensor detects the recording, all
synchronized cameras will start alarm recording.

* ALARM OUTPUT: Specify the alarm output channel if it is detected by the alarm
sensor. The alarm will be output to the specified channel.

«  LI@): Specify the output of the buzzer if an alarm is detected by the alarm sensor.
d | : Select to display the video popup if an alarm is detected by the alarm sensor.

If there exist multiple LINKED CAMERA, the video popup will be displayed in the
maximum split screen mode.

. : Select to display the OSD popup message if it is detected by the alarm
sensor.

e 1] I_>_/'@ : Select to send an email if detected by the alarm sensor.
3. To apply the change, click APPLY at the bottom of the screen.

4. When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Motion Sensor Settings

In this menu you can set an action to execute when a motion is detected. For the motion sensor
detection settings, see Motion Sensor on page 59.

1. From SYSTEM SETUP » EVENT, select MOTION SENSOR (see Figure 4-52).

2. Usethe A, ¥, 4, and P> buttons on the remote control or use the mouse to specify the
ignorance interval and operation.

¢ IGNORING INTERVAL: Specify the minimum interval of the motion event occurrence.

For example, even if you have set the minimum frequency to 5 seconds and another
motion event occurs in less than 5 seconds after the last motion event occurred, the
new event will be ignored. If too many motion events occur, adjust to shorten the
interval.

Note  Motion recording will be triggered immediately after the motion occurred
regardless of the above settings.

e ALARM OUTPUT: Specify the alarm output channel if a motion is detected by the
motion sensor.

| L©)): Specify the output of the buzzer if a motion is detected by the motion sensor.

| : Select to display the video popup if a motion is detected by the motion
Sensor.

* L IE7Y: Select to send an email if a motion is detected by the motion sensor.
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Figure 4-52 Motion Sensor Event Options
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CANCEL APPLY

3. To apply the change, click APPLY at the bottom of the screen.

4. When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Video Loss Settings

You can specify a reaction to the case where no video is received from the camera.
1. From SYSTEM SETUP » EVENT, select VIDEO LOSS (see Figure 4-53).

Figure 4-53 Video Loss Event Options

EVENT
ALARM OUT {{=]) BUZZER EI VIDEO POPUP [ oso poruP E EMAIL
ACTION
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SYSTEM EVENT N/A -
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N/ -
NfA -
NfA -
N/A -

CANCEL APPLY
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2. Usethe A, ¥, 4, and P> buttons on the remote control or use the mouse to specify the
reaction to a video loss

e ALARM OUT: Specify the alarm output channel if a video loss occurs.
. : Specify the output of the buzzer if a video loss occurs.

. : Select to send an email if a video loss occurs.

To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower

part of the screen. The confirmation message appears and you will return to the previous
menu.

System Event Settings

You can set any action to an event related to the disk, recording, network or system. Like the

other events, you may notify the event to the user using the alarm/buzzer output, OSD pop-up
or email.

1. From SYSTEM SETUP » EVENT, select SYSTEM EVENT.

2. Usethe A, ¥, 4, and P> buttons on the remote control or use the mouse to specify the
reaction to each event.

3. To apply the change, click APPLY at the bottom of the screen.

4. When finished, press the EXIT button on the remote control or click CLOSE in the lower

part of the screen. The confirmation message appears and you will return to the previous
menu.

Disk System Event Settings

Figure 4-54 Disk System Event Settings
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* OVERWRITE START EVENT: If you set the disk write mode to OVERWRITE, this event
occurs when the disk is full and the overwriting begins accordingly.

e DISK FULL EVENT: If you set the disk write mode to ONCE, this event occurs when the
disk is full (100%).

* DISK SPACE EXHAUSTED EVENT: Event that is triggered if the disk is almost full.
Click H to specify the threshold percentage of usage to trigger the event.
* S.M.A.R.T EVENT: Ocecurs if the disk causes the S.M.A.R.T error.

* NO DISK EVENT: Occurs if no disk is recognized after the booting due to a disk failure or
cable problem.

CAUTION To detect the disk error, it is recommended not to
change the settings of the S.M.A.R.T event, no disk event and buzzer
output.

Record System Event Settings

PANIC RECORD START EVENT: Specify the action to perform when the panic recording
begins.

Figure 4-55 Record System Event Settings
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System Event Settings

* BOOTING EVENT: This event occurs when the DVR is booting.

* LOGIN FAIL EVENT: This event occurs when the DVR fails to log in.
You can specify the times of clicking H to trigger the event.

* FAN FAIL EVENT: This event occurs if the CPU cooling fan or unit's cooling fan does not
work at all.
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Note If the fan fails, no recording will proceed by the DVR. If you encounter a fan
failure, contact the retailer or the service center for technical assistance.

CAUTION To monitor the normal operation of the DVR, it is
recommended not to change the buzzer output settings of the fan failure
event.

Figure 4-56 System Event Settings

EVENT
CEE N s T
ALARM OUT
{{o}) BUZZER [#] viDEO POPUP [i] 050 POPUP Eg EMAIL
EVENT NOTIFICATION ACTION
EVENT TYPE
ALARM OUT -

ALARM SENSOR BOOTING EVENT

LOGIN FAIL EVENT
MOTION SENSOR FAN FAIL EVENT

TEMPERATURE FAIL EVENT
VIDEOD LOSS

SYSTEM EVENT

TAMPER EVENT

CANCEL APPLY

Network System Event Settings

¢ TROUBLE IN INTERNET CONNECTION: Occurs if the Internet connection to the DVR
fails.

If you do not want to connect the DVR to the network, leave the ACTION item blank.

* FAIL IN REMOTE LOGIN: This event occurs if a remote client fails to log in due to an
invalid ID or password.

You can specify the times of clicking l to trigger the event.

* FAIL IN DDNS UPDATE: This event occurs if the DVR tried to update the DDNS address
but failed.
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Note If the DDNS address fails to be updated, the DVR may not connect to a
remote client. If this is the case, enter the IP address from the client side
to allow access from the DVR. This is just a temporary measure.

For the IP address, move to and check EXTERNAL IP ADDRESS from
the NETWORK window. Note that the EXTERNAL IP ADDRESS is
subject to change if the DVR does not use the static IP.

CAUTION Note that the EXTERNAL IP ADDRESS can change at
any time in a dynamic IP environment.

Figure 4-57 Network System Event Settings

EVENT
S N R < or
ALARM OUT
{{o}) BUZZER [#] viDEO POPUP [i] 050 POPUP Eg EMAIL
EVENT NOTIFICATION ACTION
EVENT TYPE
ALARM OUT -
ALARM SENSOR TROUBLE IN INTERNET CONNECTION
FAIL IN REMOTE LOGIN
MOTION SENSOR FAIL IN DDNS UPDATE

VIDEO LOSS

SYSTEM EVENT

TAMPER EVENT

CANCEL APPLY

Tamper Event Settings

You can set how to react upon a detected tampering event. To set the tampering event detection
in for each channel, see Tamper Detection on page 62.

1. From SYSTEM SETUP » EVENT, select TAMPER EVENT (see Figure 4-58).

2. Use A, ¥, 4 and P> buttons on the remote or the mouse to set the detection interval and
its action.
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Figure 4-58 Tamper Event Settings

EVENT
ALARM OUT (o)) BUZZER [7] VIDEO POPUP [@) os0 POPUP G EMAIL
ACTION
EVENT NOTIFICATION LINKED CAMERA - | ALARMOUT -|m ) | m [ | mGg
1 - N/A -
ALARM SENSOR 2 - N/A -
3 - N/A -
MOTION SENSOR 4 - N/A -
5 - N/A -
VIDEO LOSS 6 - N/A =
7 - N/A -
SYSTEM EVENT E: - N/A =
g - NfA -
10 - N/A - \-&f‘
11 - NfA -
1 - N/A -
13 - N/A -
14 - N/fA -
15 - N/A -
16 - N/A -

CANCEL APPLY

* IGNORING INTERVAL.: Sets the minimum interval of one event detection.

For example, if it is set to 5 seconds and a tampering attempt is detected within 5
seconds from the previous event, the detection is ignored and regarded as the same
event. Set this interval to a longer one if tampering detection reports too frequent.

* LINKED CAMERA: Select the camera to output the event action upon a tampering
detection.

* ALARM OUT: Set the alarm out channel for detected tampering event.

- : Sets whether to sound beeper upon a tampering detection.

. : Sets whether to display a video popup upon a tampering detection.

. H |_7'@ : Sets whether to send an email notification upon a tampering detection.
To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.
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Recording Setup

You can configure the record settings for the DVR. Only authorized users can access the Record
Setup menu.

Opening the Record Setup Menu

Using the Mouse

-

Using the Remote Control
“ Q  SEARCH
I Qg O ARCHIVING
5 & SYSTEM SETUP
o A
v — v

0 SHUTDOWN

Q  SEARCH
© ARCHIVING

SYSTEM SETUP
( @& RECORD SETUP '

0 SHUTDOWN
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Record Setup

Operation Mode Settings

In this menu you can set the recording options for Auto or Manual mode.
1. From RECORDING menu, select OPERATION MODE.

2. Usethe A, ¥, 4, and P> buttons or use the mouse to set RECORDING
CONFIGURATION MODE to AUTO CONFIGURATION or MANUAL CONFIGURATION.

Set the recording options for each selected Record mode.
To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Auto Configuration Settings

If you choose your preferred record mode, the DVR will recommend you the optimized settings
for the selected record mode (see Figure 5-1).

Figure 5-1  Operation Mode Auto Configuration

RECORDING

OPERATION MODE «RECORDING CONFIGURATION MODE

MODE AUTO CONFIGURATION

«AUTOMATIC RECORD CONFIGURATION MODE

O CONTINUOUS RECORD  HIGH QUALITY BUT SHORT DURA... =
MOTION RECORD
ALARM RECORD
MOTION/ALARM RECORD
INTENSIVE MOTION RECORD
INTENSIVE ALARM RECORD
INTENSIVE MOTION/ALARM RECORD

«PANIC RECORDING OPTIONS

PANIC RECORDING TIME MANLIAL

* ALWAYS HIGH VIDEO QUALITY: Recording will proceed in the best quality regardless of
the event at all times.

As this option will always make recording in the best quality, the recording period is the
shortest compared to the other record modes.

*  MOTION RECORD: Recording will proceed only if a motion is detected.
« ALARM RECORD: Recording will proceed only if an alarm event occurs.
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* MOTION/ALARM RECORD: Recording will proceed only if a motion is detected or an
alarm event occurs.

e INTENSIVE MOTION RECORD: Normally recording will be performed in a normal quality.
However, the quality will switch to high if a motion is detected.

* INTENSIVE ALARM RECORD: Normally recording will be performed in normal quality.
However, the quality will switch to high if an alarm event occurs.

* INTENSIVE MOTION/ALARM RECORD: Normally recording will be performed in normal
quality. However, the quality will switch to high if an alarm event occurs or a motion is
detected.

Note Motion: Normally, it means the movement of an object. However, it
implies a change to the illumination in the context of the DVR.

For example: Vehicle lights (headlights), illumination change, and so on.

Manual Configuration Settings

If you set the record mode to MANUAL CONFIGURATION, the manual configuration window
(see Figure 5-2) will appear where you can set the manual recording and panic recording
options.

Figure 5-2  Operation Mode Manual Configuration

RECORDING
OPERATION MODE #RECORDING CONFIGURATION MODE
MODE MANUAL CONFIGURATION -
CONTINUOUS RECORDINC
sMANUAL CONFIGURATION OPTIONS
SCHEDULE MODE DAILY - =
PRE RECORDING TIME 5 SEC
POST RECORDING TIME 30 5EC

KSTREAMING «PANIC RECORDING OPTIONS

PANIC RECORDING TIME MANLUIAL

* MANUAL CONFIGURATION OPTIONS: You can configure the recording settings by the
time, date, and channel.

* SCHEDULE MODE: Set the recording schedule for a day (daily) or for a week
(weekly).

* PRE RECORDING TIME: Set the pre-recording time.
*« POST RECORDING TIME: Set the post-recording time.

* PANIC RECORDING OPTIONS: Set the panic recording duration. If it is set to MANUAL
CONFIGURATION, recording will continue until you turn it off manually.
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Continuous Recording Settings

You can configure the settings of: continuous recording time, recording size, frame rate per
second (FPS) and quality.

1. From the RECORDING menu, select CONTINUOUS RECORDING.

Note = From OPERATION MODE, you must set RECORDING CONFIGURATION
MODE to MANUAL CONFIGURATION before you can set the CONTINUOUS
RECORDING.

2. Usethe A, ¥, <4 and P buttons on the remote control or use the mouse to select either
SIZE/FPS/QUALITY or SCHEDULE.

Size/FPS/Quality Settings
1. Please select the day of the week to perform the continuous recording.

From OPERATION MODE, you must set the SCHEDULE MODE of the MANUAL
CONFIGURATION OPTIONS to WEEKLY before you can specify the DAY.

2. Click a time cell from which you want to edit the SIZE/FPS/Quality and drag it to a desired
cell (see Figure 5-3).

Orusethe A, ¥, 4, and P> buttons on the remote control to move to the cell and press
ENTER. Then, use the A, ¥, 4, and P> buttons to move to a desired cell and press
ENTER again.

Figure 5-3  Continuous Recording Size/FPS/Quality

RECORDING

s
OPERATION MODE -

MOTION RECORDING

ALARM RECORDING

PANIC RECORDING

NETWORK STREAMING

AUDIO MAPPING

3.  When the cell selection is complete, the SIZE/FPS/QUALITY table appears (see
Figure 5-4).

CAUTION Specify the RESOLUTION, FPS, QUALITY and use of
the AUDIO recording for each channel.
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MOTION RECORDING

ALARM RECORDING
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NETWORKSTREAMING

AUDIO MAPPING

4.
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* RESOLUTION: Set the size of the video recording.
e FPS: Set the frame rate per second.

*  QUALITY: Set the recording quality.

* AUDIO: Specify the use of the audio recording.

Figure 5-4  Size/FPS/Quality Table

piicncininry BV

1 SIZE/FPS/QUALITY

B, CAM1 30 *  HIGHEST = OFF -
a0 *  HIGHEST  ~ OFF -
m 30 v HIGHEST =~ OFF .
T 30 ~  HIGHEST  ~ OFF -
EL} +  HIGHEST = OFF -
a0 +  HIGHEST  ~ OFF -
a0 ~  HIGHEST = OFF -

V8 30 +  HIGHEST  ~ OFF -

v 0 ~  HIGHEST  ~ OFF -
™ cAM10 30 - HIGHEST - OFF »
30 ~  HIGHEST - OFF -
30 ~  HIGHEST  ~ OFF -
30 - HIGHEST  ~ OFF -
a0 »  HIGHEST  ~ OFF -
30 ~  HIGHEST = OFF -

I I
When finished, click OK.

You can check the recording size in the size table under the time selection bar.

CAUTION The video resolution and the FPS options available to
select may differ depending on the specification of the connected

camera.

Schedule Setting

1. Select a start day of the week on the schedule.

2. Click a time cell from which you want to make the schedule and drag it to a desired cell.
Oruse the A, ¥, 4, and P> buttons on the remote control to move to the cell and press
ENTER. Then, use the A, ¥, 4, and P> buttons to move to a desired cell and press
ENTER again.

3.  When the time selection is complete, you will be prompted to specify the use of recording
in the Record Setup window (see Figure 5-5).

4. To apply the change, click APPLY at the bottom of the screen.

5.  When finished, press the EXIT button on the remote control or click CLOSE in the lower

part of the screen. The confirmation message appears and you will return to the previous
menu.
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Figure 5-5 Continuous Recording Schedule Setup

RECORDING

OPERATION MODE

MOTION RECORDING

ALARM RECORDING

PANIC RECORDING

NETWORK STREAMING

AUDIO MAPPING

998995599558 599595888%

Motion Recording Settings

Specify the recording quality of the motion event if it occurs and make a schedule for that
recording.

1.  From the RECORDING menu, select MOTION RECORDING (see Figure 5-6).
Figure 5-6  Motion Recording Settings

RECORDING

OPERATION MODE

SCHEDULE

CONTINUOUS RECORDING
ALARM RECORDING
PANIC RECORDING
NETWORK STREAMING

AUDIO MAPPING

7999993 338998588

2. Usethe A, ¥, <4 and P> buttons on the remote control or use the mouse to select either
SIZE/FPS/QUALITY or SCHEDULE.

3. Set each item of RESOLUTION, FPS, QUALITY and use of the AUDIO for the motion
recording.
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Note  The SIZE/FPS/QUALITY and SCHEDULE setup is performed the same as
was described in the Continuous Recording Settings section (page 108).
For more information on setting resolution, FPS and quality, see
Size/FPS/Quality Settings on page 108. For more information on setting
a motion recording schedule, see Schedule Setting on page 109.

4. To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Alarm Recording Settings

Specify the recording quality of the alarm event if it occurs and make a schedule for that
recording.

1.  From the RECORDING menu, select ALARM RECORDING (see Figure 5-7).

Figure 5-7  Alarm Recording Settings

RECORDING
openaTON viooe SRR
CONTINUOUS RECORDING
MOTION RECORDING : RESOLUTION FPS QUALITY

PANIC RECORDING

NETWORK STREAMING

AUDIO MAPPING

2. Usethe A, ¥ <« and P buttons on the remote control or use the mouse to select either
SIZE/FPS/QUALITY or SCHEDULE.

3. Set each item of RESOLUTION, FPS, QUALITY and use of the AUDIO for the alarm
recording.

Note  The SIZE/FPS/QUALITY and SCHEDULE setup is performed the same as
was described in the Continuous Recording Settings section (page 108).
For more information on setting resolution, FPS and quality, see
Size/FPS/Quality Settings on page 108. For more information on setting
a alarm recording schedule, see Schedule Setting on page 109.
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4. To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Panic Recording Settings

In panic recording mode, you can specify the recording resolution and quality of the video.
1.  From the RECORDING menu, select PANIC RECORDING (see Figure 5-8).

Figure 5-8  Panic Recording Settings

RECORDING

OPERATION MODE

CONTINUOUS RECORDING

MOTION RECORDING

ALARM RECORDING

NETWORK STREAMING

AUDIO MAPPING

2. Set each item of RESOLUTION, FPS, QUALITY and use of the AUDIO for the panic
recording.

Note  The SIZE/FPS/QUALITY setup is performed the same as was described
in the Continuous Recording Settings section (page 108).
For more information on setting resolution, FPS and quality, see
Size/FPS/Quality Settings on page 108.

To apply the change, click APPLY at the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Network Streaming Settings

You can specify the maximum size of network streaming for remote users and set the FPS
(frames per second).
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Note  Even if you set the resolution and FPS to high for the network streaming, the DVR
will reduce the size or FPS according to the network status (speed) before
transferring the recording video.

1.  From the RECORDING menu, select NETWORK STREAMING (see Figure 5-9).

Figure 5-9  Network Streaming Settings

RECORDING
OPERATION MODE

MAX RESOLUTION

CONTINUOUS RECORDING
MOTION RECORDING

ALARM RECORDING

PANIC RECORDING

AUDID MAPPING

ENABLE ADAPTIVE STREAMING CONTROL FOR REMOTE CLIENTS.

T

2. Usethe A, ¥, 4, P, and ENTER buttons on the remote control or use the mouse to
select an item that you want to edit.

Set the MAX RESOLUTION and MAX FPS for each channel.
When finished, click OK.
To apply the change, click APPLY at the bottom of the screen.

o o M w

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.

Audio Mapping Settings
1. From the RECORDING menu, select AUDIO MAPPING (see Figure 5-10).
2. Setthe AUDIO IN of the AUDIO MAPPING screen.
3. To apply the change, click APPLY at the bottom of the screen.
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Figure 5-10 Audio Mapping Settings

RECORDING
OPERATION MODE
CONTINUOUS RECORDING e
MOTION RECORDING ADIOA
ALARM RECORDING
PANIC RECORDING
AUDIO 3
AUDIO 4
AUDIO 1
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o
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o
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AUDIO 4

4.  When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.
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Searching

You can search for the recording data in the HDD by the criteria of time, thumbnail, event, and

SO on.

Opening the Search Menu While Monitoring

Using the Mouse

-

Q SEARCH )

© ARCHIVING
& SYSTEM SETUP

@& RECORD SETUP '

0 SHUTDOWN

Using the Remote Control (Method 1)

<o

@

@&

Q  SEARCH )
© ARCHIVING

& SYSTEM SETUP
l . @& RECORD SETUP '

0 SHUTDOWN

Using the Remote Control (Method 2)

SEARCH
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Opening the Search Menu While in Playback Mode

Using the Mouse

-

Using the Remote Control

SEARCH

O ARCHIVING T —>

© LIVE

Search Settings

Time Search

With the calendar, you can search for the recording data by the recorded date.
1.  From the SEARCH menu, select TIME SEARCH (see Figure 6-1).
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Figure 6-1 Time Search Window

SEARCH

THUMBNAIL SEARCH EVENT SEARCH
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07-24-2013 D1:53:04 AM THUMBNAIL

&

E KCHECE KNS

{16 /16)

07:23.2013 0153:10 AM A

2. Usethe A, ¥, 4, and P> buttons or use the mouse to specify the search date and time
from the calendar in the left corner of the screen.

*  FIRST: The first date of recording is automatically selected.
e LAST: The last date of recording is automatically selected.

. : Press this to display the time selection menu where you can specify the time
and date (see Figure 6-2).

Figure 6-2 Time Search Changing Date and Time

SEARCH

THUMBNAIL SEARCH EVENT SEARCH

W ere pecoroinG [ conTinuOUS

W ALaRm B moTion

4 JuLY 2013
SUN MON TUE WED THU FRI SAT

12 (s [l s|s
7 (8|9 |10f11f22]|28

14 (1516 [17 [18 |19 2

(21 | 22 Hl: 25 | 28 | 27

|28 |29 (30 31

[“res N oS |

= i b
07-24-2013 01:53:04 AM

DATE/TIME : o o = : Ho/tol

YEAR MON DAY HOUR MIN SEC

e
2013 07 24 01 53 04
b o i i i

oK CANCEL

07-24-2013 01:54:10 AM
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You can identify the type of the recording data by the color in the bar.

*  Yellow green (Pre-recording): The pre-recording is performed on the recording data
after you set the PRE RECORDING TIME from OPERATION MODE.

* Green (Continuous): The continuous recording is performed on the recording data.
* Red (Alarm): The alarm event recording is performed on the recording data.

*  Blue (Motion): The motion event recording is performed on the recording data.

* Yellow (Panic): The panic manual recording is performed on the recording data.

Click to move to a desired start time in the time bar, or use the buttons at the bottom of the
status bar to make search.

. : Recall the recording data.
. -G Expand the timeline of the time bar to a greater unit of time.
. -@ Collapse the timeline of the time bar to a smaller unit of time.

. ﬁ: Use this to move to a previous time that is hidden in the time bar as it is
expanded to a greater time unit.

. : Use this to move to a next time that is hidden in the time bar as it is expanded
to a greater time unit.

Click a thumbnail channel or use the A, ¥, 4, and P> buttons on the remote control to
move to a desired channel and press ENTER. You can check the video in PREVIEW.

CAUTION Click to move to a desired time, or simply double-click
a desired time in the time bar to play the video data on that time.

Press the ENTER button again on the remote control with the mouse, or simply
double-click on the channel. You will move to the playback screen.

If you want to stop playing back and return to the search screen, press EXIT or SEARCH
on the remote control. You can also click MENU in the lower left corner and select a
desired menu.

Thumbnail Search

To improve your search, you will be provided with a list of thumbnails.

Select Day, Hour or Minute to narrow down the search results.

1.
2.

From the SEARCH menu, select THUMBNAIL SEARCH.

Use the A, ¥, 4, and P> buttons or use the mouse to specify the search date and time
from the calendar in the left corner of the thumbnail search screen.

* FIRST: The first date of recording is automatically selected.
* LAST: The last date of recording is automatically selected.
* CHANNEL: Select a channel to search for.

* DATE/TIME: Specify the search date and time.

Note  The menus available differ depending on the selected interval mode.

¢ INTERVAL: Select a time interval of the thumbnail view from MINUTES (see
Figure 6-3), HOURS (see Figure 6-4), or DAYS (see Figure 6-5).
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3. Double-click a desired play time in the recording data bar, or double-click a desired time
image from the thumbnail list.

The playback screen will open.

4. If you want to stop playing back and return to the search screen, press EXIT or SEARCH
on the remote control. You can also click MENU in the lower left corner and select a
desired menu.

Figure 6-3 Thumbnail Search - Minutes Selection

SEARCH TIME SEARCH THUMBNAIL SEARCH EVENT SEARCH
W rre pecoroing [l conTiNUDUS W Acaam [ moTioN PANIC
] JuLy 2013 »
SUN MON TUE WED THU FRI | _ -
—- THUMBMAIL : MINLITES {60/ 60)

1 1 3 4 5

8|9 |w|aajaz|a

14 |15 |16 |17 |18 19 | 20

21 |22 P23 24 | 25 | 26 | 27

w2 |30 | N

CHANNEL CAM 1 -
DATE/TIME 07-24-2013 01H
INTERVAL MINUTES -

PREVIEW

07-24-2013 01:00:07 AM

PLAYBACK

Figure 6-4 Thumbnail Search - Hours Selection

SEARCH TIME SEARCH

SEARCH

W rre pecoroing [l conTiNUDUS W Acaam [ moTioN PANIC
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w2 |30 | N
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PREVIEW
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Figure 6-5 Thumbnail Search - Days Selection
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Event Search

Search for events that occurred at the specified time and select an event to play from the list.
1. From the SEARCH menu, select EVENT SEARCH (see Figure 6-6).

Figure 6-6  Event Search Screen

SEARCH TIME SEARCH THUMBNAIL SEARCH

FROM 07-24-2013 10:23:32 AM
TO 07-24-2013 10:28:32 AM

e 1
[ [ i A —————
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~vIDEO RECORD I O e
wstsTEM jsrorace | NN
CINETWORK  [VITAMPER I N S
setup T I

2. Usethe A, ¥, 4, and P> buttons or use the mouse to specify the START and END times
in the left of the event search list.

3. Select a channel to search.
4. Mark the checkbox of the event to search from the EVENT list.
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Press the SEARCH button. The search results will be listed as shown.

¢ TYPE: Displays the event type.

* TIME: Displays the recording start time.

e CONTENTS: Shows the details of the event found.

* ORDER BY: If you select OLDEST, the list will be sorted with the earliest one on top.

Double-click a desired event or click PLAY in the lower right corner to open the playback
screen.

If you want to stop playing back and return to the search screen, press EXIT or SEARCH
on the remote control. You can also click MENU in the lower left corner and select a
desired menu.
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Playback

To playback video from search results:

* You can search for and playback search results (see Chapter 6, Searching).

To play video with the live viewer:

*  Simply double-click a desired time point in the right corner of the play screen.

Note If you move the cursor to the rightmost, the Timeline bar will be displayed.

e Select a desired channel in the live screen and right-click to select PLAY in the
context menu. Then, select a desired play time.
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Playback Screen Configuration

Figure 7-1  Playback Screen
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selection menu

Video Window

Displays the current video.

Timeline

Displays the type of recording data.

The vertical bar in the timeline indicates the current point of playback. Double-click a desired
point in the timeline to start playing the video from that point.

Once you drag to specify an area, you can perform the backup or event search for that area.

Menu/Split-Screen Selection Menu

For more information about how to use each button in this menu, refer to Using the Status Bar
in Live Mode on page 48.
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Playback Controls

You can start playing, stop playing or change the play speed of the current video.

Table 7-1 Playback Controls Descriptions

Iltem Description
Jump d » Move forward or backward.
Reverse Fast Play “ Zh>e ;iciine?h\i/;ilcl)?dee:eversely played at the speed of x64 > 32 > 16 > 8 >
Reverse Play 4 Play the video in the reverse direction.
Pause n Stop playing forward, or any playback temporarily.
Play > Play the video forward.
Fast Forward The video will be played forward at the speed of xX2 < 4 < 8 < 16 < 32
L < 64 in this order.
Zoom In @\ Move to the zoom in/out screen of the selected channel.
Capture the current live video and save it in the .jpeg format. Then, you
Snaoshot can save the captured images in the HDD or export it to an external USB
P memory device.
While you perform the snapshot, the current video will stop playing.
Add a bookmark for the current playback screen.
Press this to display the SET BOOKMARK window. Provide each entry
Start/End and click Start. The arrow in the bookmark button blinks to indicate that
B:okmark o the bookmarking is in process. If you press the Bookmark button again,

the bookmarking stops and the current settings will be reserved.

Then, the reserved data can be backed up in ARCHIVE menu or can be
played in the RESERVED DATA MANAGEMENT menu.

Playback Channel Selection Menu

Table 7-2 Playback Context Menu Description

Iltem Description
CAM1 Display the title of the selected channel.
Zoom Zoom the video of the selected channel (the zooming function is active

only in the single channel split screen).

Start Bookmarking The Set bookmark popup appears, and you can bookmark a play
point for the backup purpose.

Snapshot Capture Capture the current live video and save it in the .jpeg format.
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Bookmarking

MENU

i

During playback, you can add a bookmark for reserving the video data. You can view the
bookmarked data in the Archive menu, which can be saved to a connected device for backup.

1.

2.

Press the BOOKMARK button ( @ ). The BOOKMARK SETUP window opens (see
Figure 7-2).

Provide a tag in the TAG item for data reservation.

Figure 7-2  Bookmarking

Honeywell
07232013
|
TAG AVI CHANNEL
w|CH1 [w|CH2 VECHB v CHA
0 VicHs [vlcHs [VoHr [wicHs |
VvitHI  [w]cH10 vcH11 [vlcH12
|CH13 [V|CH14 [/]eH15 []cH1e
~* \CODEC
Q@ a v
mm EEsm 07-23-2013
am o= EE B 06:05:01 AM . « «n > »is 0 Q@ E
3. Provide the details of the reserved data in the MEMO input field.
4. Click START. You will return to the play screen with the backup progress.
5. To stop the bookmarking, click BOOKMARK ( @ ).
6. To quit the bookmarking, click STOP.

To continue with bookmarking, just click CONTINUE.
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Figure 7-3  Reserving a Bookmark
Honeywell

[N

AVI CHANNEL

Eci: Bz oz @oia
Ecis Ecis Eoi7 Eoss RT———
Bcie EcHio @lcHin Econn2
Bcri3 ElcHis @lcHls @llciie

| [Tale} Bicooec

: TR T o 07-23-2013
vew T [l BE EEE G 06:05:14 AM S« « 1> » 0 QB

7. Click RESERVE.

You can export the reserved data to a connected storage device using the ARCHIVE
menu.

Note What is the RESERVE function?

With the RESERVE function, you can reserve data even in overwrite
mode. This is useful if you want to backup data but you have no backup
device available such as USB memory. If you use Reserve, the
recording days will be compromised. When you have backed up the
reserved data to an external device, it is recommended to delete the
internal reserved data.
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Archiving

Opening the Archive Menu

Using the Archive Menu During Playback

During the playback, click NEW ARCHIVE ( @ ).

The ARCHIVING SETUP window appears where you can reserve the data.
Click MENU in the lower left corner and select the ARCHIVE menu.

Press the ARCHIVE button on the remote control.

H w0 p o~

Using the Archive Menu During Monitoring

1. Click MENU in the lower left corner and select the ARCHIVE menu.
2. Press the ARCHIVE button on the remote control.

Archiving Options

Creating a New Archive

You can archive the searched data or reserve it.
1. From the ARCHIVE menu, select NEW ARCHIVING (see Figure 8-1).

2. Select a date for the archive from the calendar in the left.
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Note  The date containing recording data will be marked in a colored box.
e FIRST: The first date of recording is automatically selected.
* LAST: The last date of recording is automatically selected.

Figure 8-1  New Archiving

ARCHIVING

RESERVED DATA MANAGEMENT ARCHIED DATA PLAYBACK ARCHIVE DEVICES SETUP

W ere pecoroinG [ conTinuOUS W ALaRm B moTion PANIC

4 JuLy 2013
SUN MON TUE WED THU FRI SAT
[ Talz]s T| 5|6
i? [8 |8 [10|1]12 ]2

14 (15 (16 (17 [ 18 [ 19 | 20

[ [ = [ ||
[ 8 | 29 | 30 ;- | | |
EEE EEE = [Ee.

| PREVIEW {16/ 186)

FROM 07-23-2013 06:05:17 AM  [E3]
TO 07-23-2013 06:10:17 AM  FEg]
[]LOG [v|conEc

ARCHIVING INFO

RELEASE QUERY

3. Check the START and END times.

Note  Drag the timeline to specify the start and end time.

4. Mark the LOG and CODEC checkboxes and select to include the archiving.
5. Click QUERY. The results will be listed in ARCHIVING INFO (see Figure 8-2).

Note  The maximum backup capacity for one time is 20 GB.

If the archiving request exceeds 20 GB, the end time will be adjusted to
within 20 GB.

6. If you want to export the data to a storage device, connect the storage device to the DVR
and click EXPORT.
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Figure 8-2  Archiving Info Retrieved
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7. If you just want to reserve the data, click RESERVE. If the TAG NAME dialog appears,
enter the name and click OK.

Click RESERVE to save it to the HDD.

Note  Using RESERVE will compromise the recording days available. When you have
archived the reserved data to an external device, it is recommended to delete the
internal reserved data.

8. To exit the Archive menu, click CLOSE.

Reserved Data Management

You can search for the reserved data and delete or import it to a storage device.
1. From the ARCHIVE menu, select RESERVED DATA MANAGEMENT.
The reserved data will be listed (see Figure 8-3).
2. Select a data type from AVl and SNAPSHOT CAPTURE.
e AVI: Searches AVI video files stored in the DVR.
* SNAPSHOT CAPTURE: Searches captured snapshots stored in the DVR.
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Figure 8-3 Reserved Data Management

ARCHIVING | NEWARCHIVING il ARCHIVED DATA PLAYBACK ARCHIVE DEVICES SETUP

I

3. If you want to play the data, double-click a desired data item or click it and select PLAY.

Note If selecting SNAPSHOT CAPTURE, the PLAY button will be disabled.

4. If you want to export to a storage device, connect the storage device to the DVR and click
EXPORT.

5. If you want to delete the reserved data, click next to the list. Click CANCEL ALL to
cancel reserving the whole page at once.

6. To exit the Archive menu, click CLOSE.

Playing the Archived Data

You can search the storage device for the archived data and check the details of data or play it.
1. Connect the storage device containing the archived data.
2. When the storage device is recognized, click SEARCH (see Figure 8-4).
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Figure 8-4  Searching for Archived Data on a Storage Device

ARCHIVING NEW ARCHIVING | RESERVED DATAMANAGEMENT ARCHIVE DEVICES SETUP

STORAGE DEVICE USB Flash Disk

n 11 “ VERIFY INTEGRITY

oo |

3. To view the details, click next to the list (see Figure 8-5).

Note Click VERIFY INTEGRITY to check if the data is corrupt or incomplete.

Figure 8-5  Archived Data Info

ARCHIVE DEVICES SETUP

ARCHIVING NEW ARCHIVING | RESERVED DATAMANAGEMENT

STORAGEDEVICE  usB Flash Disk - =N

SIZE SET BY
I |
ARCHIVED DATA INFORMATION

#DETAIL INFORMATION

FILE NAME : ch01_130723134640_130723134848_00_33MB_ADMIN.avi
ARCHIVED AT : 07-24-2013 10:53:26 AM
RESERVED AT :

MOVIE START : 07-23-2013 01:46:40 PM
MOVIE END : 07-23-2013 01:48:48 PM
TAG:3

USER : ADMIN

MEMO :

DST: ON

FILE SIZE : 33.5 MB

FRAME COUNTS : 4237

VIDED FRAME : INCLUDED

AUDIO FRAME : INCLUDED

n 7 “ VERIFY INTEGRITY

4. Select an item to play from the list and click PLAYBACK.
5. To exit the Archive menu, click CLOSE.
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Archive Devices Setup

Provide the FTP server information for archiving data in the HDD before testing the transfer.
From the ARCHIVE menu, select ARCHIVE DEVICE SETUP (see Figure 8-6).

1.

ARCHIVING

oFTP

HOST NAME
PORT

USER NAME
PASSWORD
DIRECTORY

Figure 8-6  Archive Device Setup

NEW ARCHIVING RESERVED DATA MANAGEMENT ARCHIVED DATA PLAYBACK ARCHIVE DEVICES SETUP

ARCH

'CONNECTION TEST

Move to the FTP information box.

Fill in each item using the virtual keyboard:

HOST NAME: Enter the address at which you can access the server.
PORT: Enter the port number to which you can access the server.
USER NAME: Enter the user ID with which you can access the server.
PASSWORD: Enter the connection password.

DIRECTORY: Specify the archiving path.

When all information is filled, click CONNECTION TEST to check the connection status.
To apply the change, click APPLY in the bottom of the screen.

When finished, press the EXIT button on the remote control or click CLOSE in the lower
part of the screen. The confirmation message appears and you will return to the previous
menu.
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Web Viewer

Overview

Web RA is a user-friendly software application that enables you to control the video data in
connection with a remote DVR.

System Requirements

The following is the minimum hardware and operating system requirements to run Web RA.

Table 9-1 System Requirements

ltem Requirement

Operating System Windows XP Professional
Windows Vista Home Basic/Premium
Windows 7

Web Browsers Internet Explorer 7.0 or later/Mozilla Firefox 3.6/Google Chrome 4.1/Opera 10.

Some web browsers other than Internet Explorer may not fully function.

CPU Intel Pentium 4 /2.0 GHz or higher

Memory 512 MB

Display 16-bit 1024 x 768 High Color

Hard Disk Drive 50 MB (space required for installing the web viewer)

Note Additional HDD space is required for saving your recording data. The file
size of your recording may differ depending on the specified quality.

Connection

Open a browser and enter the IP address of DVR, or type the URL in the address bar.
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Connecting to the DVR from Inside

¢  Check the Network Status and verify the IP ADDRESS and WEB SERVICE PORT of the
DVR (see Network Status on page 80 for more information).

* Enter the IP address and web service port in the address bar of the browser.
For example: http://192.168.1.200:8080

Figure 9-1 DVR URL in the Address Bar

G & http://192.168.0.59:8080/html/live.htm

File Edit View Favorites Tools Help

Connecting to the DVR from Outside

Using the IP Address

e Check the Network Status and verify the EXTERNAL IP ADDRESS and WEB SERVICE
PORT of the DVR (see Network Status on page 80 for more information).

* Ifusing afixed (external) IP, enter the external IP that is specified in the DVR in the address
bar of the web browser.

For example: If the internal IP address is set to http://222.112.4.48:8080
(192.xxx.XxX.XXX), no access from outside is allowed.

Using the URL

e Check the Network Status and verify the DDNS ADDRESS and WEB SERVICE PORT of
the DVR (see Network Status on page 80 for more information).

* Enter the DDNS address and web service port in the address bar of the browser.
For example: http://00115f123456.DVRLINK.NET: 8080

Note In a router network, you have to set the Port Forwarding and DMZ Setting to allow
access from outside.

Note For the necessary settings of the router, refer to the router’s user manual or
contact the router’s manufacturer.

Logging in to the Web Viewer

1. Provide the user ID and password (see Figure 9-2).

Note The default User name is ADMIN; the default Password is 1234.
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Figure 9-2  Web Viewer Login

Windows Security =

The server 192.168.0.59 at WEB Remote Viewer requires a username and
password.

Warning: This server is requesting that your username and password be

sent in an insecure manner (basic authentication without a secure
connection).

!'_ = ] IUsername ‘
l |E‘ | Password ]

"] Remember my credentials

[ oK ][ Cancel ]

Click the upper warning bar to install the ActiveX control.

Note If you fail to download the ActiveX control, move to Tools » Internet Options >
Security » Custom Level » Download unsigned ActiveX control, and
change its setting from Disable (recommended) to Enable, and then click OK.

Figure 9-3  ActiveX Control Install

Control’ from "AHOPE Co., LTD.".  What's the risk? Install

Click Install.

When the installation is complete, you will see the live screen (see Figure 9-4).

Figure 9-4 Web Viewer Live Screen

WEB Remote

STATUS
CHANNEL NO, 1 2 R 5 [ 7 8 g1 112 SR R e
ALARM IN (DYR)
MOTION
WIDEQ LOBS ¥ ¥ ¥ ¥ ¥ ¥ ¥ KK Y YR ¥
RECORDING [P]

ALARM OUT (DY)
AEFFESH Bsec [
REFRESH
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Web Viewer: Live

Live Screen at a Glance

Figure 9-5 Web Viewer Live Screen Descriptions

WEB Remote

8
o A N (DAY e

MOTION
YIDED LOSE ¥ ¥ ¥ o8 B ¥ B V¥ ¥ R R B
RECORDING P]
aLafk OUT (DR
REFFEEH |3 sec |v
REFRESH
\ —— S
~—o
Table 9-2 Web Viewer Live Screen Descriptions
No. Name Description

1 View Selection Tab You can switch to the live, playback and setup screens and check the provided information.

2 Live Screen Display the live screen of the currently connected DVR.

3 Split Mode Select and switch to a desired split-screen mode.
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Table 9-2 Web Viewer Live Screen Descriptions (cont’d)

No. Name

Description

4 Sequence

Set the sequence mode, switch to the next camera or select the full screen mode.

Status Show the connection status of each channel.
Log Show the log.
° Refresh Time Set the interval at which the DVR Status is refreshed.
Reload Load the DVR Status immediately.
6 ¥?aizesmission You can turn on or off the output of the voice signal.
7 Channel Select a channel listed in the screen.
Save Save the live video on the screen.
Print Print out the current screen.
8 Capture Capture the selected image.
ActiveX Settings ~ Configure the ActiveX settings or specify the saving path of the captured image.

Switching the Split Mode

Click the Switch button to switch the mode as shown in Figure 9-6.

Figure 9-6  Split Screen Modes

Bim #a

1-Split Mod

s e e [I'ED

4-Split Mod

8-Split Mode

= L

Vs

S | R
CHE % mox »a srgime B Baeze

16-Split Mod

CHES % mox »e sreme B Baee

9-Split Mode

Saving the Video

Click | [E | to start saving.

The video from the selected channel will be saved to the PC in the AVI format. The default
path is C:\SaveFolder.
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Click again to stop saving. Click ActiveX Setting to display the context menu where
you can change the saving path.

Click & .

The current screen will be printed with the printer connected to the PC.

Capturing a Screen Image

1. Click .
2. The current screen of the selected channel will be saved to the path specified in the PC.
The default path is C:\SaveFolder.
Click ActiveX Setting to display the context menu where you can change the saving path.
ActiveX Settings
1. Click %% (see Figure 9-7).
Figure 9-7  ActiveX Settings
Render
" DirectDraw Sync I
DI Live CH cHl =
[ Deinterlace
Capture Type
& pG " BMP
Stream
[V 1Frame only Type m
Save Folder
[C:WSaveFolder _'
Ok | Cancel |
2. When the setup screen appears, you can change the settings of the render type, audio,
capture and saving path as well as the video streaming.
Render: DirectDraw is recommended in order to enable the hardware acceleration.
3. [If you want to change the saving path, click ... | (Save Folder) and specify a new path.
The Windows Vista user cannot change the saving path.
4. Change the streaming settings according to the PC specification and network

environment.
Auto mode is recommended.

e Sync: If this option is set, the audio signal will be synchronized with the video signal.
However, you may encounter a delay due to buffering for the synchronization.

* Live CH: Set the audio signal to use in live monitoring mode.

* | Frame Only: Only the | frames (key frames) will be transferred.
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e Type:

¢  Auto: The DVR will optimize the quality and FPS to the network status and
specification of the connected PC before transferring the data.

* Main: The video will be transferred in high definition (HD).
e Second: The video will be transferred in a medium definition (SD).

5. When finished, click OK to save your settings.

Status Tab
Click STATUS at the bottom of the screen (see Figure 9-8). You can check the event occurrence
for each channel of the connected DVR.
Figure 9-8  Web Viewer Live Screen Status Tab
STATUS
CHANNEL NO,
ALARM IN (DVR)
MOTION
VIDEO LOSS
RECORDING
ALARM OUT (DVR}
3 sec :I
REFRESH
Log Tab
Click LOG at the bottom of the screen (see Figure 9-9). You can check the log of the connected
DVR.
Figure 9-9  Web Viewer Live Screen Log Tab
LOG
1 21 15:00:05 LIVE: opened by ADMIN,
2 CAMI 1 145053 RECORD: Camera #01 starts panic recording,
3 1 14:50:50 SYSTEM: System star,
PAGE DOWN PAGE UP 3 sec i]
REFRESH
PTZ Tab

Click PTZ at the bottom of the screen (see Figure 9-10). You can control the operations of a PTZ
camera. Adjust the focus, zooming and iris of the camera. You can use the arrow buttons to
control the operations of the camera.

* Pattern: You can configure various settings of the camera including the zooming and
movement. (Applied to some PTZ cameras only).

* PRESET: Move the camera in a predefined direction.

* Swing: The camera will move back and forth to a set position.
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Figure 9-10 Web Viewer Live Screen PTZ Tab

PTZ
Pattern Swing -
Set Run v]
PRESET =
: M stEP
Set Run 5 i]

Web Viewer: Searching

Click SEARCH to display the remote control screen for the DVR.
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Search Viewer at a Glance

Figure 9-11 Web Viewer Search Screen Descriptions
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Table 9-3 Web Viewer Search Screen Descriptions

No. Name Description

1 View Selection Tab You can switch to the live, playback and setup screens and check the provided information.

2 Playback Screen  Plays the recording data.

3 Split Mode Select and switch to a desired split-screen mode.

Set the sequence mode, switch to the next camera or select the full screen mode. You can

4 n ; .
Sequence turn on/off the voice signal.

5 Play Button Bar You can control the playback screen.

6 Time Selection Specify the start time of playback.

7 Time Line Indicates the status of the recorded data.
Refresh Reload the time line.

8 Play Play the video that satisfies your search criteria.
Export Archive the video that satisfies your search criteria.
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Table 9-3 Web Viewer Search Screen Descriptions (cont’d)

No. Name Description

9 Channel Selection Select a channel listed in the screen.

Screen Print out the current screen.

10 Image Capture Capture the selected image.

ActiveX Settings ~ Configure the ActiveX settings or specify the saving path of the captured image.

Search By Time

Use the timeline to search for the data recorded in the DVR (see Figure 9-12).

1. Select a date that you want to search.

Figure 9-12 Web Viewer Search By Time

SEARCH BY TIME

2013 [~]/ 01 [&]01 [¥] 15 [v] 24 [v] (08 [¥ REFRESH PLAY EXPORT

R Tl
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2. Click REFRESH.

3. Check the existence of recording data in the bottom time line and specify the time range
for your search. You can specify the start time by moving the time bar.

4. Click PLAY.
* REFRESH: If your changes are not applied to the current screen, reload the changes.
* PLAY: Play the searched video.

* Backup: Archive the recorded video.

Search By Event

You can sort the recording data items by event to facilitate your search (see Figure 9-13).
1. Mark the checkbox of the event that you want to search for.

2. Specify the start and end dates and times for your log search.
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Figure 9-13 Web Viewer Search By Event
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3. Set the display order of the items found.

e LATEST: The most recent event will be listed on top.

* OLDEST: The earliest event will be listed on top.
4. Click SEARCH.

You can check the log for your search at the bottom of the screen.
5. Select a log to play the recording data.

Web Viewer: Setup

Click SETUP to display the remote control screen for the DVR.

When finished, click OK to apply the changes to the remotely connected DVR.

Note If the DVR is in process of system or record setting, the remote control will be
disabled.

CAUTION If you often change the settings remotely, the major
Record Settings of the DVR may be changed, which is not recommended.
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Setup Viewer at a Glance

Figure 9-14 Web Viewer Setup Screen

CAMERA CAMERA TITLE
+ CAMERA TITLE CHANNEL CAMERA T

IMAGE SETUP ALL [ l
COVERT SETUP ! [cAm1 |
H [CAMZ ]

MOTION SENSOR
3 [CAM3 |
PTZ SETUP a CAWa ]
TAMPER 5 [CAMB ]
& DISPLAY 5 CAMB ]
= AUDID 7 [CamM7 ]
= USER 8 [CAma ]
9 CAM3 ]

@ NETWORK.
0 [CAM10 ]
¥ SYSTEM I [CAMT1 ]
= STORAGE 12 CAM12 ]
EVENT 13 [cAM13 ]
s RECORD 14 [CAM14 ]
15 CAM15 ]
16 [cCAM16 ]
APPLY || CANCEL |

Camera Settings

Naming the Camera Title

You can name the camera title that is displayed on each channel screen. Select a channel to
name and provide a new title (see Figure 9-15). Then, click APPLY to apply it.

Figure 9-15 Naming a Camera Title

CAMERA TITLE

CHANNEL CAMERA TITLE

ALL [

1 [CAM1
2 [cAMZ
3 [cAM3
4 [cAMA
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8
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16 [cAM1E

APPLY || CANCEL
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Note  You can enter up to 9 alphanumeric characters for the camera title.

Covert Setting

You can set to hide the video of a specific camera from a specific user (see Figure 9-16). Set to
hide the camera video so that a specific user or user group can not view. To change the covert
settings from user group to user, move to the USER menu and make necessary changes. When
finished, click APPLY to apply the changes.

Figure 9-16 Web Viewer Covert Setup

COVERT SETUP

APPLY CANCEL

Motion Setting

Specify the use of motion detection and reaction for each channel and set also the
daytime/nighttime options (see Figure 9-17).

Select a channel. Set the mask area and activation and specify the daytime range.

When finished, click APPLY to apply the changes.

Note For more information about how to set the motion area, refer to Setting the Motion
Area on page 60.

800-15802 - A - 12/2013



148 | Performance Series HREP2 DVR User Guide

Figure 9-17 Web Viewer Motion Sensor Setup
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Figure 9-18 Web Viewer PTZ Setup
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To make DVR utilize camera’s PTZ functions, match the protocol and baud rate of connected

cameras and DVR (see Figure 9-18).

Tamper Setup

You can set to detect tampering attempts to interfere with monitoring operations by tampering

with installed cameras (see Figure 9-19).

Note  For more information about how to set the Tamper settings, refer to Tamper

Detection on page 62.

Figure 9-19 Web Viewer Tamper Setup

TAMPER

15 [v] 15 [¥] [15

MARK

h 1 [v]
Blockage/Redirection Defocusing
ON ¥
E [9:00 [¥]~[18:00
SENSITIVIT

PESEN EVEL SPATIAL TEMPORA
DAYTIME (15 [¥] (15 [¥] 15 [+
icrase| 1ON [~] = [¥] [ ON

¥

SELECT ALL| DESELECT ALL]

|

ENSITIVIT
LEVE SPATIAL | TEMPORAL
15 [v] 15 [¥] (15 [¥]

Ellﬁ M 15 ¥ 15 [¥]

[ apPLY |[__CANCEL

Display Settings

OSD Settings

Configure the settings for the time, title, boundary, icon and language that will be displayed on

the screen (see Figure 9-20).

Make changes to each item of the OSD menu and click APPLY to apply the changes.
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Note  For more details about each displayed item, refer to OSD Settings on page 64.

Figure 9-20 Web Viewer OSD Settings

0SsD
On v]
On ﬂ
On V|
Auto Hide v|
Auto Hide v|
On v
DarkGray V|
ENGLISH v|
APPLY CANCEL

Monitor Settings

You can set the interval of an active sequence (see Figure 9-21). Specify the interval and click
APPLY to apply it.

* Sequence Dwell: Switching time from one channel to the next channel in single screen
mode.

* Spot Dwell: Setting the interval between the view types when displaying the SPOT Out
monitoring screen.

* HD Spot dwell: Select the dwell time of one channel displayed on the monitor, when
using HD monitor Spot Out.

Figure 9-21 Web Viewer Monitor Settings

MONITOR

5 Sec
5 Sec
1 Sec

<ll«ll<

APPLY CANCEL

Audio

Audio/Buzzer

You can configure the settings of the voice and audio signal (see Figure 9-22).

Note  For more details about each displayed item, refer to Audio Setup on page 72.
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Figure 9-22 Web Viewer Audio Setup

AUDIO
off ]
On v
On v
BUZZER
On ﬂ
APPLY CANCEL

User Settings

User Management

You can add a user account and change the password (see Figure 9-23).

Figure 9-23 Web Viewer User Management

USER MANAGEMENT

MIN seee | ADMIN v

ADD APPLY CANCEL

Note  For more details about each displayed item, refer to User Settings on page 73.

To add a user, click ADD and provide the user information (see Figure 9-24).
If you want to delete the user click DEL next to that user.

When finished, click APPLY to apply the change.
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Figure 9-24 Web Viewer Adding a User

USER MANAGEMENT

MIN Ty | ADMIN w
ADD APPLY CANCEL
ADD »x
USERID |
PASSWORD |
GROUP [ADMIN  [v]
EMAIL |

EMAIL NOTI. OFFE]
COVERTCHANNEL (1 [12 [03 [J4
Os e Or [
09 010 1 012
13 014 15 16

< >

OK Close

Group Permission Setting
You can grant different user groups different permissions to a specific menu (see Figure 9-25).

Mark the checkboxes of the menu items to be accessible by the user group.

Figure 9-25 Web Viewer Group Authority Setup

GROUP AUTHORITY
SEARCH ™ O
ARCHMVING O O
SYSTEM SETUP v O
RECORD SETUP = 0
EVENT ACTION CONTROL o M
LISTEN TO AUDIO i v
MIC [~ [
REMOTE LOG IN £
SHUTDOWN i [

APPLY CANCEL

When finished, click APPLY to apply the changes.

Note  For more information about the accessible menu items, refer to Group Authority
Settings on page 76.
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IP Setup
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You can check the network connection status and change the baud rate (see Figure 9-26).

Change the maximum transfer rate and click APPLY to apply it.

Figure 9-26 Web Viewer Network Settings

IP SETUP

M

192.168.0.59
192.168.0.1
2552552550
168.126.63.1
168.126.63.2

5554
8080

MAX v

APPLY CANCEL

Note

For more information about each network entry, refer to IP Setup on page 77.

DDNS Settings

You can configure the DDNS settings so that remote users who are connected to the network

can access remotely (see Figure 9-27).

Change the DDNS settings and click APPLY to apply the changes.

Figure 9-27 Web Viewer DDNS Settings

DDNS

On v
dvrlink net

00115ff0a2d8
00115ff0a2d8.dvrlink.net

APPLY CANCEL

Email Settings

You can register and test an email address so that an email notification is delivered at a specific
interval or if an event occurs (see Figure 9-28).

Provide the necessary information and click APPLY to apply it.
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Note For more information, refer to Email Settings on page 79.

Figure 9-28 Web Viewer Email Settings

EMAIL

OFF v|

TEST

APPLY CANCEL

System Settings

Date/Time Settings
Specify the current date and time (see Figure 9-29).

When finished, click APPLY to apply the changes.

Note For more information about each of the time and date settings, refer to Date/Time
Settings on page 82.

Figure 9-29 Web Viewer Date/Time Settings

DATE/TIME
MM/DD/YYYY ™
24 Hour v
NETWORK TIME SYNCHRONIZATION
[pootntp.org |
OFF v
0:00 v
TIMEZOME / DST
GMT-05:00 America/EST v
On ﬂ
APPLY CANCEL

System Management

You can configure the access settings of: log in, log out, and auto logout (see Figure 9-30).
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Figure 9-30 Web Viewer System Management

SYSTEM MANAGEMENT
On ﬂ
Not Used :ﬂ
Off :l
1 Min. [v]
APPLY CANCEL

System Information

You can check information of system firmware version, disk space, and network settings, as well
as the status information of network connection and alarm I/O (see Figure 9-31).

Figure 9-31 Web Viewer System Information

SYSTEM INFORMATION
31310.1.700000.100
N/A
MANS300_FH
298.1 GB
103.3GB
1
192.168.0.59
00115ff0a2d8
00115ff0a2d8.dvrink.net
5554
8080
HOMI(1080P-60)

STATUS

Control Device Setting
Set the connection of both the remote control and the keyboard control (see Figure 9-32).

Change the communication settings and click APPLY to apply the changes.

Figure 9-32 Web Viewer Control Device Settings

CONTROL DEVICE
DEVICE 0 ] D-Max [v] 9600 v

APPLY CANCEL

Note For more information about each communication item, refer to Control Device
Settings on page 87.
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Storage Settings

Device Information

You can check a list of internal/external storage devices connected to the DVR as well as the
recording time information of each device (see Figure 9-33).

Figure 9-33 Web Viewer Device Information

DISK INFORMATION

Internal

10-07-2012 22:56:05 05-21-2013 15:53:14
10-07-2012 22:56:05 05-21-2013 155314 IN USE WDC WD320044 NORMAL

S.M.A.R.T Status

You can check the S.M.A.R.T status for each of the internal and external devices (see
Figure 9-34).

Figure 9-34 Web Viewer S.M.A.R.T. Setup

S.M.A.R.T. SETUP

internal

NORMAL

DETAIL

Note What is S.M.A.R.T.?

This is a sort of HDD self-diagnosis tool that detects any error on the
system and alerts the user if an error occurs.

Sensor Settings

Alarm Output Settings
Specify the alarm output conditions (see Figure 9-35) with the work schedule (see Figure 9-36).

When finished, click APPLY to apply the changes.
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Note  For more information about the alarm output and ON/OFF schedule, refer to
Alarm Out on page 92.

Figure 9-35 Web Viewer Alarm Output

ALARM OUTPUT

ALARM OUT ON/OFF SCHEDULE

AO1 [a01 ] DIGITAL OUT N/O ~] [5sec ~]
AO2 [0z ] DIGITAL OUT N/O [v] [5 sec v
APPLY CANCEL

Figure 9-36 Web Viewer Alarm Schedule

ALARM OUTPUT
ALARM OUT | ON/OFF SCHEDULE

DAY | Sun _\';'l
= B ofFF Il oN EVENT

01 2 3 4 5|6 7 8 9 10 11|12 13 14 15 16 17 |18 19 20 21 22 23

A1

AO2

COPY SCHEDULE TO

APPLY CANCEL

Event Notification

Specify the notification method using one of BUZZER OUT (see Figure 9-37), DISPLAY (see
Figure 9-38) and EMAIL (see Figure 9-39) against an event alarm that occurs.

Specify the buzzer output time, display time and email notification, and click APPLY to apply the
changes.

Note For more information about the event notification, refer to Event Notification on
page 94.

Figure 9-37 Web Viewer Buzzer Out Event Notification

EVENT NOTIFICATION

BUZZER OUT DISPLAY EMAIL

BUZZER OUT

APPLY CANCEL
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Figure 9-38 Web Viewer Display Event Notification

EVENT NOTIFICATION

BUZZER OUT DISPLAY EMAIL

VIDEO POPUP
5 sec vl
OSD POPUP
5 sec v
APPLY CANCEL

Figure 9-39 Web Viewer Email Event Notification

EVENT NOTIFICATION
BUZZER OUT DISPLAY EMAIL

EMAIL NOTIFICATION
LIST

1 Min vl

APPLY CANCEL

Alarm Sensor Settings

You can configure the settings of the alarm sensor and specify the operation of the sensor if an
event occurs (see Figure 9-40).

When finished, click APPLY to apply the changes.

Note For more information about each of the alarm sensor actions, refer to Alarm
Sensor Settings on page 97.

Figure 9-40 Web Viewer Alarm Sensor Settings

ALARM SENSOR

&1  [SENSOR1_| [HIGH

3 1 =l =z
Az [SENSORZ | HIGH [v] ¢ - m
43 [SENSOR3 | [HIGH [v] v| [N - [

A4 [SENSOR4 | [HIGH

APPLY CANCEL

Motion Sensor Settings

You can set an action to execute when a motion is detected (see Figure 9-41).

When finished, click APPLY to apply the changes.
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Note For more information about how to set the motion sensor, refer to Motion Sensor
Settings on page 98.

Figure 9-41 Web Viewer Motion Sensor Settings

MOTION SENSOR
380 ] = . 0 ] _
b sec l] A 0
3 5 sec ] | (- = 0
§ | & = - 0 -
5 5 sec l] WA = i
6 5 sec ] [N = 0 =
2 5 sec v A = I 0 C
[} 5 sec l’] WA =
9 5 sec [v] (& = o o 0
10 5 sec [v] (ma = ;
il 5 sec .\LI Nk = r r
12 5 sec V] e T
13 5 sec Bl | [ = = =
14 5 sec :{ﬂ W T
15 5 sec l] NA [
16 b sec 3] [ = [ 0
APPLY CANCEL

Video Loss Settings

You can select an action for BUZZER and EMAIL and determine what to do on the alarm output
port if no video is received from the camera (see Figure 9-42).

When finished, click APPLY to apply the changes.

Figure 9-42 Web Viewer Video Loss Settings

VIDEO LOSS

1 1 - O
2 L . [ 4
3 - 4
4 - O O
3 L - [ O
6 J 4
7 - = O
8 A - [ 4
9 L L 4
10 - O
" A - i

12 - [ [

13 - - [ O
14 1A - O
15 L . a
16 A - [

APPLY CANCEL
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Tamper Event Settings

You can set how to react upon a detected tampering event (see Figure 9-43).

Figure 9-43 Web Viewer Tamper Event Settings

Tamper Event setting

1 5 sec EI faa | | O >
2 5 sec [v] (Ma w| | - -
3 5 sac :E] s - =
4 5 sec o Lo v v
5 5 sec [v] [Mea - -
6 5 sec [3] [ - -
? 5 sec [S] [nea - i -
8 5 sec [ae] |nea

9 5 sec li o ] | -
0 5sec ::f o b
1 5 sec 1' ! o -
12 5 sec Eﬂ -~ - >
13 5 sec Ea e -
14 & sec :d A - B -
15 b sec Ea e = -
16 5 sec [v] = | I i

APPLY

CANCEL

When finished, click APPLY to apply the changes.

Note  For more information about how to set the Tamper Event, refer to Tamper Event

Settings on page 103.

System Event Settings

You can set which action to perform if an event related to the disk (see Figure 9-44), recording
(see Figure 9-45), network (see Figure 9-47) or system (see Figure 9-46) happens. You may
want to notify the user of the event using the alarm output, buzzer, OSD popup and email.

When finished, click APPLY to apply the changes.

Figure 9-44 Web Viewer System Event Status - Disk

SYSTEM EVENT STATUS

DISK RECORD SYSTEM NETWORK

OVERWRITE START EVENT

DISK FULL EVENT "
DISK SPACE EXHAUSTED EVENT 90%[w] WA
SMART. EVENT Nsa
NO DISK EVENT Nia =

APPLY

) v v
[ il
CANCEL
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SYSTEM EVENT STATUS

DISK RECORD SYSTEM NETWORK

PANIC RECORD START EVENT

APPLY CANCEL
Figure 9-46 Web Viewer System Event Status - System
SYSTEM EVENT STATUS
DISK RECORD SYSTEM NETWORK
BOOTING EVENT =
LOGIN FAIL EVENT RETRY 3 TIMES[w] (W= O
FAN FAIL EVENT L1 - v ™
TEMPERATURE FAIL EVENT - M [+
APPLY CANCEL
Figure 9-47 Web Viewer System Event Status - Network
SYSTEM EVENT STATUS
DISK RECORD SYSTEM NETWORK
TROUBLE IN INTERNET CONNECTION O
FAIL IN REMOTE LOGIN RETRY 3 TIMES[w] M* m|
FAIL IN DDNS UPDATE RETRY 3 TINESE s ] i
APPLY CANCEL

Note  For more information about how to set the system event, refer to System Event

Settings on page 100.

Recording Setup

Record Settings

You can set the recording options for Auto (see Figure 9-49) or Manual (see Figure 9-48) mode.

When finished, click APPLY to apply the changes.
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Figure 9-48 Web Viewer Recording Configuration - Manual

RECORDING CONFIGURATION MODE
Manual ﬂ
MANUAL CONFIGURATION OPTIONS
1 Daily __v|
5 Sec ﬂ
30 Sec ]
PANIC RECORDING OPTIONS
Manual ﬂ
APPLY CANCEL

Figure 9-49 Web Viewer Recording Configuration - Automatic

RECORDING CONFIGURATION MODE
Automatic vl

AUTOMATIC RECORD CONFIGURATION MODE

) ALWAYS HIGH VIDEO QUALITY

® MOTION RECORD
ALARM RECORD
MOTION/ALARM RECORD
INTENSIVE MOTION RECORD

O INTENSIVE ALARM RECORD

) INTENSIVE MOTION/ALARM RECORD

PANIC RECORDING OFTIONS

Manual ﬂ

APPLY CANCEL

Note For more information about how to set each mode, refer to Operation Mode
Settings on page 106.

Continuous Recording Settings

You can configure the settings of: continuous recording time (see Figure 9-51), recording size,
frame rate per second and quality (see Figure 9-50).

Click [V next to each item to display the list of values available.

When you complete the recording size and schedule settings, click OK to apply your settings.
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Figure 9-50 Web Viewer Continuous Recording - Size/FPS/Quality

CONTINUOUS REC

u SIZEFPS/QUALITY | SCHEDULE

o

12

18

RESOLUTION FPS QUALITY AUDID
CAM1 960x480 [~ 30 [™]  Highest [¥] off [~
CAM2 960%480 & 30 [*]  Highest [¥] off ~]
CAM3 960x480 ¥ 30 [¥]  Highest [v] off v
CAM4 960x480 M 30 v Highest [V off 4]
CAMS 960x480 M 30 [¥]  Highest [v] off 2
CAMG 960x480 M 30 [¥]  Highest ¥ off v
CAMT 960%480 30 [v Highest ¥ off ~]
CAMB 960x480 ¥ 30 [¥]  Highest ¥ off v
CAMS 960x480 0 [%]  Highest [~ off ~]
CAM10 960x480 & 20 [~ Highest [] off ~]
CAMT1 960x480 ™ 30 [™]  Highest [ off £
CAM12 960x480 & 30 [¥]  Highest [v] off ]
CAM12 960x480 ¥ 30 [%]  Highest [+ off vl
CAM14 960x480 [w 30 [¥]  Highest [V off ~
CAM1S 960x480 [ 20 [%]  Highest [~ off ~]
CAM16 960x480 [ 20 [w]  Highest [v] off ™)
[ APPLY || CANCEL |
Figure 9-51 Web Viewer Continuous Recording - Schedule

CONTINUOUS REC

TIME

CAM15

L SIZEFPSIOUALITY J SCHEDULE |

=]

_ SELECT ALL || REVERSE ALL || DESELECT ALL

APPLY

CANCEL |

Note

For more information about the continuous recording size and schedule, refer to
Continuous Recording Settings on page 108.
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Motion Recording Settings

Set the SIZE/FPS/QUALITY/AUDIO (see Figure 9-52) and the SCHEDULE (see Figure 9-53) to
apply if a motion event occurs.

Click next to each item to display the list of values available.

Figure 9-52 Web Viewer Motion Recording - Size/FPS/Quality

MOTION REC
| SIZEFPSIQUALITY | SCHEDULE J
0 5 12 18 24
RESOLUTION FPS QUALITY AUDIO
CAM1 960x%480 30 [¥]  Highest [#] off vl
CAM2 960x480 > 30 [%]  Highest [~ off (]
CAM3 960x480 ¥ 30 [¥]  Highest [V off [~
CAM4 960x480 &~ 30 [¥]  Highest [*] off v
CAMS 960x480 [~ 30 [%]  Highest [¥] off [v]
CAMS 960%480 ¥ 30 [¥]  Highest [+ off [¥]
CAM? 960x480 > 30 [™]  wighest [v off £3]
CAMS 960x480 v 30 [v]  Highest v off [v]
CAME 960x480 ¥ 30 [»]  Highest ¥ off [v]
CAM10 960x480 > 30 [¥]  Highest [v]  off [~
CAM11 960x480 ¥ 30 [v]  Highest [s] off [v]
CAM12 960x480 ¥ 30 [¥]  Highest [V off ¥
CAM13 960x480 M 30 [¥]  Highest [ off V]
CAM14 960x480 & 30 [  Highest v off [v]
CAM15 960x480 & 30 v Highest M off [~
CAM16 960x480 B | 30 [»]  mighest [»] off [~
[ APPLY || CANCEL |

Figure 9-53 Web Viewer Motion Recording - Schedule

MOTION REC

[_smmnumw J SCHEDULE .I J'

0 6 12 13 24
TIME | |

e
oAMS -l.ll-l .l-l.ll-

=
cAM2 .-
CAM3
CAM4
o I I-
1 o L

CAMS
CAMI
CAM10
CAM11
CAM12
CamM13

cAM14 I -l-l.
CAM15
. IHE CEEEER I= IH

| seect Al || REVERSE ALL || DESELECT ALL |

= ek

[ aPPLY || cCANCEL |

Complete setting the SIZE/FPS/QUALITY/AUDIO for the motion recording as well as the
SCHEDULE, and click OK to apply the changes.
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Note  For more information about the motion recording size and schedule, refer to
Motion Recording Settings on page 110.

Alarm Recording Settings

Set the SIZE/FPS/QUALITY/AUDIO (see Figure 9-54) and the SCHEDULE (see Figure 9-55) to

apply if an alarm event occurs.
Click [V next to each item to display the list of values available.

Complete setting the SIZE/FPS/QUALITY/AUDIO for the alarm recording as well as the
SCHEDULE, and click OK to apply the changes.

Note For more information about the alarm recording size and schedule, refer to Alarm

Recording Settings on page 111.

Figure 9-54 Web Viewer Alarm Recording - Size/FPS/Quality

TIME

CAM1
CAMZ
CAM3
CAM4
CAMS
CAME
CAMT
CAMS
CAMI
CAM10
CAM11
CAM12
CAM13
CAM14
CAM15

CAM16

ALARM REC

SIZE/FPS/QUALITY

SCHEDULE

1] 6 12 18 24

960x480
960x480
960x480
960x480
960x480
960x480
960x480
960x480
960x480
960x480
S60x480
960x480
960x480
960x480
960x480
960x480

(<l [<] (<] [<] [<] [ [l ][] [ [ ] [ [ ] [

a0
30
30
30
30
30
30
30
30
20
30
30
30
30
30
30

[« [«] (<] [<] [«] [«] [l [<] <] [<] [<] [e] [] [] [¢] [€]

Highest
Highest
Highest
Highest
Highest
Highest
Highest
Highest
Highest
Highest
Highest
Highest
Highest
Highest
Highest

Highest

APPLY

Off
Off
Off
off
off
off
off
off
Off
off
off
off
Off
off
off

<] [¢] [€] [¢] [¢] [x

Off

[ [¢] [< [« [€ (< [« [« [<] [«

CANCEL

v
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Figure 9-55 Web Viewer Alarm Recording - Schedule

ALARM REC

SIZEFPSIQUALITY SCHEDULE

TIME

SELECT ALL REVERSE ALL || DESELECT ALL

APPLY CANCEL

Panic Recording Settings

From the PANIC RECORD menu, you can set the resolution, FPS, quality and audio settings to
your preference (see Figure 9-56).

Click || next to each item to display the list of values available.

Figure 9-56 Web Viewer Panic Recording Settings

PANIC REC
| 30 wv| Highest b Off -
w 30 | Highest v Off o
v 30 | Highest ~ Off hd|
| 30 v Highest v Off v
~ 30 | Highest ~ Off ~
v 30 v| Highest v Off v
w 30 w Highest ~ Off v
w 30 v| Highest ~ Off v
960x480 | 30 | Highest w Off -
960x480 v| 30 v| Highest ~ Off w
960x480 hd| 30 w| Highest w Off ~
960x480 v 30 w| Highest v Off w
3 ~ 30 \_4-_: Highest ~ Off ~
AM14 | 30 w| Highest v Off v
CAMIS 960x480 v 30 v Highest ~ O ~
CAMIE 960x480 v 30 ~ Highest ~ Off v
APPLY CANCEL

When you have completed the manual record settings, click OK to apply the changes.
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Note  For more information about the manual record settings, refer to Panic Recording
Settings on page 112.

Network Streaming Settings

You can specify the maximum size of network streaming and video resolution for remote users
and change the FPS (see Figure 9-57).

Click [V next to each item to display the list of values available.

When done, click OK to apply the settings.

Figure 9-57 Web Viewer Network Streaming Settings

NETWORK STREAMING
CAMI 960x480 I~ 30 v
CAM2 960x480 v| 30 v|
CAM3 960x480 v 30 v
CAM4 960x480 v 30 vl
CAMS 960x480 ] 30 ]
CAME 960x480 v 30 v
Cam? 960x480 V| 30 V]
CaME 960x480 v 30 [v]
CaMI 960x480 v 30 V|
Camil 960x480 v 30 v
CAMII 960x480 v 30 v
CAaMIZ 960x480 v 30 v
CAM13 960x480 v 30 v|
CaM14 960x480 v 30 |
CAMIS 960x480 v 30 v
CAMIG 960x480 v 30 v
APPLY | CANCEL

About

Click the INFORMATION tab to check the model name of the DVR as well as the web viewer
version (see Figure 9-58).

Figure 9-58 Web Viewer Information

Web Viewer Information

DVR Model : 16CH / 480FFPS
WEB Version : WEB_v2,1,2.1,2,7,9.120622
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Mobile Viewer

HREP2 Mobile Remote Viewer Overview

You can use the HREP2 smart mobile remote viewer to monitor the network on a remote site
and play the monitoring video anytime, anywhere.

HREP2 Mobile Viewer Specification

Minimum / Recommended Specification

Table 10-1  Mobile System Requirements

Device Minimum Specification Recommended Specification
Processor: 800 MHz or higher Processor: 1 GHz or higher
Flash: 512 MB or higher Flash: 512 MB
Android Phone RAM: 512 MB or higher RAM: 512 MB
SD Card: 4 GB or higher SD Card: 16 GB or higher
0S: 2.0 or higher 0OS: 2.1 or higher
Device Supported Models Recommended Specifications
iPhone 3G iPhone 3GS or higher
iPhone OS 3.1.2 or higher iPhone OS 3.2 or higher
iPhone/iPad iPad 2 iOS 4.3 or higher
iPad 3 with Retina display iOS 4.3 or higher

iPod Touch 3rd Generation
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Using the HREP2 Mobile Viewer with iPhone/iPad

How to Download the iPhone/iPad-Dedicated Application

From your iPhone or iPad, access the App Store.

Enter HREP2 in the search bar to find the application. Download the application and install it on
your iPhone/iPad.

Note = The HREP2 Mobile Remote Viewer supports the 1/4 split screen mode.

Note  The HREP2 Mobile Remote Viewer is a free application that provides live viewing,
playback, searching, log view, PTZ control and system configuration functions.

Connecting to the DVR with HREP2 Remote Viewer

1. Select and run the HREP2 Remote Viewer application.

2. Use in the top right corner of the DVR List to select and add a site to the list (see
Figure 10-1).

Figure 10-1 iPhone HREP2 Remote Viewer Empty DVR List

DVR List 1.1.102 +

3. Enter the server name and tap Save (see Figure 10-2).
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Figure 10-2 iPhone HREP2 Remote Viewer Server Name

DVR List 1.1.102

Server Name

4. Provide the IP address, HTTP port number and RTSP port number, and tap Save (see
Figure 10-3).
Figure 10-3 iPhone HREP2 Remote Viewer IP and Ports

IP and Ports

Provide the access ID of the DVR as well as the password (see Figure 10-4).
Specify the use of the Auto Login.

Tap Save.

Figure 10-4 iPhone HREP2 Remote Viewer ID and Password

ID and Password

‘ D
| auto Login a

[ Cancel | Save ‘

8. Select the site that you added in the DVR List (see Figure 10-5).
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Figure 10-5 iPhone HREP2 Remote Viewer DVR List with Added DVR

DVR List 1.1.102 ir

00115f00a304.dvrlink.net (5)

9. Tryto access the DVR.

If connected successfully, you will see the screen as shown in Figure 10-6.

Figure 10-6 iPhone HREP2 Remote Viewer Live Screen

Split Screen Mode

1.

2.

Tap any area on the screen.

The main menu appears at the bottom of the screen (see Figure 10-7).

Figure 10-7 iPhone HREP2 Remote Viewer Live Screen with Main Menu

Tap D in the top left corner to switch to 1-split mode. Tap B to switch to 4-split mode
(see Figure 10-8).
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Note  Swipe the screen to the left or right to move to the next camera video screen.

Figure 10-8 iPhone HREP2 Remote Viewer Live Screen Quad View

QD

Disconnect

Using the Log View

1. From the main menu, tap [E&. You can check the log of the stored data (see Figure 10-9).
Figure 10-9 iPhone HREP2 Remote Viewer Log View
Back Log

Date / Time Filter Option
Start Motion

End Etc.

No. CH Date/Time

2. Select one or more from Alarm, Motion, Record, and Etc. and tap [[BY (see
Figure 10-10).

You will view the log of related items.
Figure 10-10 iPhone HREP2 Remote Viewer Log View with Filter Selected
Back L()g

Date / Time Filter Option
Start & Alarm Motion

End & Record Etc.

No. CH Date/Time Log
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Using the Search Function

1. From the main menu, tap Y. You can view the history of the stored data.
2. Select a desired time and date for searching (see Figure 10-11).

You can use the vertical time bar to specify the start time.

Figure 10-11 iPhone HREP2 Remote Viewer Time Line

Back Time Line »

Date 2011.12. 20 Rl 16:00:00 2%
o 4 1

3. Tap u to play the video recorded at the specified time (see Figure 10-12).

Figure 10-12 iPhone HREP2 Remote Viewer Playback

4. Touch any area of the screen to display the play bar with which you can control the
playing direction and speed of the video playback (see Figure 10-13).

Figure 10-13 iPhone HREP2 Remote Viewer Playback with Play Bar
B

“ime Line Live View

i g
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Using the Setup Function

From the main menu, click (see Figure 10-14).

You will be connected to the web viewer site.

Figure 10-14 iPhone HREP2 Remote Viewer Setup Screen

—

Back Setup
CAMERA CAMERA TITLE
» CAMERA TITLE CHANNEL

COVERT SETUP ALL —
MOTION SENSOR ; %
TYPE - :%

DISPLAY 3 G

AUDIO

USER

NETWORK

Note  For more details about the setup options for the DVR, refer to System Setup on
page 55.

Using the HREP2 Remote Viewer with Android

How to Download the Android-Dedicated Application

From your smart phone, access the Market.

Enter HREP2 in the search bar to find it. Download the application and install it on your Smart
Phone.

Note = The HREP2 Mobile Remote Viewer supports the 1/4 split screen mode.

Note = The HREP2 Mobile Remote Viewer is a free application that provides live viewing,
playback, searching, log view, PTZ control and system configuration functions.
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Connecting to the DVR with HREP2 Remote Viewer

1.
2.

© N o O

Select and run the HREP2 Remote Viewer application.

Press the Menu button and tap Add Connection to select and add a site to the list (see
Figure 10-15).

Figure 10-15 Android HREP2 Remote Viewer Empty DVR List

nViewer Lite 1.0.7

Add a DVR connection by

using 'Menu > Add
Connection’

Please enter a Name for the new connection (see Figure 10-16).

Provide the IP address (URL), HTTP Port number and RTSP Port number, and click
Save.

Figure 10-16 Android HREP2 Remote Viewer Add Connection Form

Save Cancel

Provide the access ID of the DVR as well as the Password.

Select whether or not to save the ID and PW.

Tap Save.

Select the site that you added in the DVR List.

Tap and hold the DVR name to display the pop-up window (see Figure 10-17).

www.honeywell.com/security



Mobile Viewer | 177

Figure 10-17 Android HREP2 Remote Viewer DVR List with Pop-Up Window

Connect

Edit

Delete

9. Tap Connect and try to access the DVR.

If connected successfully, you will see the screen as shown in Figure 10-18.

Figure 10-18 Android HREP2 Remote Viewer Live Screen

Split Screen Mode

1. Tap any area on the screen.

The main menu appears at the bottom of the screen (see Figure 10-19).

Figure 10-19 Android HREP2 Remote Viewer Live Screen with Menu

2. Tap D in the top left corner to switch to 1-split mode. Tap E to switch to 4-split mode.

Note  Swipe the screen to the left or right to move to the next camera video screen.
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Using the Log View
1. From the main menu, tap [E& (see Figure 10-20).

You can check the log of the data stored.

Figure 10-20 Android HREP2 Remote Viewer Log View

Start  2011/12/21 00:00:00 Alarm Mosion
End 01NV D0c29:28 Record Bt
No. M Date / Time Log

2. Select one or more from Alarm, Motion, Record, Etc. and click Search.

You will view the log of related items (see Figure 10-21).

Figure 10-21 Android HREP2 Remote Viewer Log View with Search Results

Start 201012021 00:00:00
End 2011112721 00:29:28

No. CH Date / Time
2011/12/21 DO:724 SEMOTELOG OFF ; LIVE BISFLAY : ADMIN: 22303142231
2 201112021 DI:ZE51 SEMOTELOG ON | LIVE BISPLAY | ADMIN: 223.93,142.321

Using the Search Function
1. From the main menu, tap E

You can view the video of the recording data.
2. Select a desired time and date.
You can use the vertical time bar to specify the start time (see Figure 10-22).
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Figure 10-22 Android HREP2 Remote Viewer Search Timeline

3. Tap Play to play the video recorded at the specified time (see Figure 10-23).

Figure 10-23 Android HREP2 Remote Viewer Playback Screen

; R

ATE: 01UMAARORARNR

4. Click any area to display the play bar with which you can control the playing direction and
speed of the video (see Figure 10-24).

Figure 10-24 Android HREP2 Remote Viewer Playback Screen with Controls

7 __-T
Time Line Live View

2>

Using the Setup Function

From the main menu, click [ . You will be connected to the web viewer site and can make
configuration changes to the unit (see Figure 10-25).
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Figure 10-25 Android HREP2 Remote Viewer Setup Screen

CAMERA TITLE

Note  For more details about the setup options for the DVR, refer to System Setup on
page 55.
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Archive Viewer

You can play the data archived in the DVR. You can also play the HDD data recorded by the
DVR.

Getting Started with the Backup Player

1. Connect the DVR to the backup USB storage device.
2. Open the folder saving the archived images.

Figure 11-1 Opening Folder of Archived Images

o) [ » ARCHIE 130102 182177 +
Fle Bt View Took Help
Onganize v | Includeinlibraey v Sharewith v Bum  Hlew folder
o Favortes PLAYER
B Deskaop o ol

& Dewnlosds
3L Becent Places

arch_info leg 130100187115 13000182122 Muits_ch 130102187115 1 3007187
g Text Document 132 00_ADMIN.id

i Librariey
I Decuments
o Music
- Pictures
H videos
s Homegroup

B rstas

3. Run the Backup Player (see Figure 11-2).
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Figure 11-2 Backup Player

Backup Player & - X

G & : | ) (v 1| €

4. Click & inthe bottom left corner to display the file browser (see Figure 11-3). Select the
archived file to play.

Figure 11-3 Selecting Archived File to Play

Open
@@v| » ARCHIVE_130102 182137 » ~ [ ¢ ||| Search ARCHIVE.
Organize v Mew folder = » Eﬂ ‘E‘
=
b Favciviies I‘_ Name Date modified Type Size
B Desktop | PLAYER 5/16/2013 10:57 AM  File folder
4 Downloads | L] Multi_ch 130102182115 130102182122 00... 1/2/2013 8:21 AM MUL File 1963 KB

=l Recent Places

m.

i Libraries
3 Documents
rJ"— Music
ks Pictures -

H videos
& Homegroup
18 Computer

&L, HP_pAVILION (C
(=a HP_RECOVERY ([ ~

File name: - [AII Supperted Files (".mul, *.avi, '|

[ open o] [ concel |

5. Check the integrity of the archived file (see Figure 11-4).

Figure 11-4 Checking Watermark of Archived File

BackupPlayer 8 Watermark Checking

Mowe Verifying. .., Please wait for some minutes.

| Would you want to check the watermark?

- |
Cancel

Yes || N0 |
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6. When finished, the archived file will be played on the screen.

Using the Backup Player

Figure 11-5 Backup Player Overview

Backup Player . X

e_

o

-

(& e &) Cee o < 0 » > » @) ( ) QD

o o o

Table 11-1  Backup Player Screen Descriptions

No. Name Description

Setup Configure the environment settings.
1

Minimize, Close Minimize or close the Backup Player.

2 Channel Information Show the channel information and the video resolution.

3 Play Time Display the time of the current video image.
4 Play Time Display the current playback time.

File Search Open the file that you backed up.
5 Capture Capture the current screen.

Print Print out the current screen.
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Table 11-1  Backup Player Screen Descriptions (cont’d)

No. Name Description

Control the playback direction and speed of the current video. For more information

6 Playback Control about how to use the playback controls, see Playback Controls on page 125.

7 Split Mode Switch to 1-/4-/9-/16-split screen mode.
8 Audio Setting Show the sound signal status and volume level.
9 Play Bar Display the current playback position in the video.

Video Capturing

Click B2 to capture the current video image (see Figure 11-6).

* Selected Video: Capture the actual frame of the current video.
e Screen: Capture the visible portion of the current video.

e Format: Select a saving format.(BMP, JPG, PNG).

e Path: Specify the saving path.

e Default location: My Documents\My Pictures

Figure 11-6 Video Capture Screen

Snap Shot

Preview:

Video: @) Selected Video (7 Sereen

Format |JPG (Ipeqg) bl

Path
C:\Wsers\thecnp'Pictures\SnapShot_01CH_2013-01-01_03-46-53-695

e R

Printing Out
Click &2 to print out the image.

When the Print window appears (see Figure 11-7), check the preview and click Print.
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Figure 11-7 Print Image Screen

Print

Screen Shot Backup Player

Channel: Screen
Resolution: 1004 x 685
Video Time: 2013/01/01 03:46:53

Backup Player Settings

Click #* to configure the Backup Player settings (see Figure 11-8). You can check the version
of the Backup Player (see Figure 11-9).

* Maintain image aspect ratio: Preserve the aspect ratio of the image.
If you do not mark this option, the image will be adjusted to fit the screen.
e I-frame Play: Only the | frames (key frames) will be played back.

e About: You can check the program information including the current version.
Figure 11-8 Backup Player Settings Screen
Settings 1

General_i About |

View Settings
@ Maintain image aspect ratio,

[ 1-frame play.

OK ] l Caneel A

=]
g=l
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Figure 11-9 Backup Player About Screen

Settings

General | About |

@

Product Name
File Version
Product Version

BackupPlayer D
0,188
0,188

[ ok ][ cancel

Apply
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Specifications

Table A-1 HREP2 DVR Specifications
Category ltem 4-Channel 8-Channel 16-Channel
INPUT SIGNAL NTSC/PAL NTSC/PAL NTSC/PAL
MAIN MONITOR VGA/HD VGA/HD VGA/HD
) . Analog 1 CH (1 Vp-p Analog 1 CH (1 Vp-p
SPOT OUT Sub monitor (Digital) - @ 75 ohms), Sub @ 75 ohms), Sub
2CH monitor (Digital) monitor (Digital)
VIDEO
Software controlled
termination /4 CH (1  Software controlled  Software controlled
LOOP THROUGH Vp-p @ 75 ohms) for termination (TBD) termination (TBD)
ANF3G-H 0412
MOTION DETECTION YES YES YES
4 CH (10,000 ohms, 4 CH (10,000 ohms, 4 CH (10,000 ohms,
INPUT SIGNAL 2.8 Vp-p) 2.8 Vp-p) 2.8 Vp-p)
AUDIO OUTPUT SIGNAL 1 CH (600 ohms, 2.8 1 CH (600 ohms, 2.8 1 CH (600 ohms, 2.8
Vp-p) Vp-p) Vp-p)
CODEC G.711 G.711 G.711
CODEC H.264 HP H.264 HP H.264 HP
Up to 120 FPS/ Up to 240 FPS / Up to 480 FPS /
100 FPS @ 960H 200 FPS @ 960H 400 FPS @ 960H
Upto 120 FPS / Up to 240 FPS / Up to 480 FPS /
100 FPS @ D1 200 FPS @ D1 400 FPS @ D1
RECORDING REC. RATE
Upto 120 FPS / Up to 240 FPS / Up to 480 FPS /
100 FPS @ 2CIF 200 FPS @ 2CIF 400 FPS @ 2CIF
Up to 120 FPS/ Up to 240 FPS / Up to 480 FPS /
100 FPS @ CIF 200 FPS @ CIF 400 FPS @ CIF
REC. RESOLUTION CIF, 2CIF, D1,960H CIF, 2CIF, D1,960H CIF, 2CIF, D1, 960H
4 CH, Pulledupto5V 4 CH, Pulledupto5V 4CH, Pulledupto5V
ALARM INPUT via 10,000 ohms via 10,000 ohms via 10,000 ohms
ALARMI/O 2 CH, RELAY 2 CH, RELAY 2 CH, RELAY
ALARM OUT (5V,35mA) (5V, 35 mA) (5V, 35 mA)
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Table A-1 HREP2 DVR Specifications (cont’d)
Category Item 4-Channel 8-Channel 16-Channel
4 EACH, 4 EACH,
INTERNAL HDD 2 EACH Up to 2 TB HDD Disk Up to 2 TB HDD Disk
STORAGE EXTERNAL STORAGE NAS (FTP Server, for eSATA, NAS (FTP eSATA, NAS (FTP
backup) Server, for backup) Server, for backup)
1 EACH (DVD-RW) 1 EACH (DVD-RW) 1 EACH (DVD-RW)
INTERNAL ODD with HDD 2 EACH with HDD 2 EACH with HDD 2 EACH
USB 3 Ports 3 Ports 3 Ports
(2 Front + 1 Rear) (2 Front + 1 Rear) (2 Front + 1 Rear)
RS-485 1 1 1
INTERFACES RS-232 1 1 1
LAN 1 (WAN) - 1 (LAN) + 1 (WAN) - 1 (LAN) + 1 (WAN) -
10/100/1000 Mbps 10/100/1000 Mbps 10/100/1000 Mbps
REMOTE CONTROL YES YES YES
SIGNAL SWITCH NTSC/PAL NTSC/PAL NTSC/PAL
ETC WATCHDOG YES YES YES
COOLING FAN Max 1x 60 mm Max 2x 60 mm Max 2x 60 mm
12V DC, Adapter,5A 12V DC, Adapter,5 A
12V DC, Adapter, 5 A, (2HDD), 100 ~ 240V (2HDD), 100 ~ 240 V
POWER SUPPLY 100 ~ 200 V AC AG, 50-60 HZ AG, 50-60 HZ
50-60 HZ ’ 12 V DC, Adapter, 12 V DC, Adapter,
POWER 6.67 A (4HDD), 100 ~ 6.67 A (4HDD), 100 ~
240V AC,50-60 HZ 240V AC, 50-60 HZ
20 W (HDD 2 each, 35 W (HDD 4 each, 35 W (HDD 4 each,
POWER CONSUMPTION Seagate Pipeline, Seagate Pipeline, Seagate Pipeline,
500 GB) 500 GB) 500 GB)
0°C ~ 40°C 0°C ~ 40°C 0°C ~ 40°C
TEMPERATURE (32°F ~ 104°F) (32°F ~ 104°F) (32°F ~ 104°F)
ENVIRONMENT o o S
HUMIDITY 10 ~ 90% 10 ~ 90% 10 ~ 90%

non-condensing

non-condensing

non-condensing

DIMENSION (WxDxH)

1.5U
(860 x 360 x 66 mm)

1.5U
(860 x 360 x 66 mm)

1.5U
(860 x 360 x 66 mm)

CHASSIS
Unit: 4.4 kg Unit: 4.4 kg Unit: 4.4 kg
WEIGHT Shipping: 7.5 kg Shipping: 7.5 kg Shipping: 7.5 kg
Emissions CE: EN 55022 class B CE: EN 55022 class B CE: EN 55022 class B
FCC: Part 15B class B FCC: Part 15B class B FCC: Part 15B class B
EN 55022: 2010 EN 55022: 2010 EN 55022: 2010
EN 61000-3-2: 2006 + EN 61000-3-2: 2006 + EN61000-3-2: 2006 +
A1: 2009 +A2: 2009 A1:2009 +A2: 2009 A1:2009 +A2: 2009
CERTIFICATION Immunit EN 61000-3-3: 2008  EN 61000-3-3: 2008  EN 61000-3-3: 2008
y EN 50130-4 EN 50130-4 EN 50130-4
EN 60950-1: 2006 + EN 60950-1: 2006 + EN 60950-1: 2006 +
A11:2009 + A1:2010 A11:2009 + A1:2010 A11:2009 + A1:2010
+ A12: 2011 + A12: 2011 + A12: 2011
Safety CSA, UL 60950-1 CSA, UL 60950-1 CSA, UL 60950-1
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Hard Drives

Compatible HDD Specifications

Table B-1 Hard Disk Drive Minimum Specifications

Specification Requirement

Maximum SATA Speed * SATAT1 (1.5 G): Can be used
¢ SATA2 (3.0 G): Can be used

* SATAS3 (6.0 G): Devices of backward compatibility
to SATA2 (3.0 G) can be used.

Maximum Start-up Current 12V, 2 A (or lower)

Maximum Average Operation

Power Consumption 7.0 W (or lower)

Maximum R/W Latency Latency (Read: 13 ms / Write: 13 ms) or smaller

Note  Use 3.5" HDD disks.

Note  Using HDD devices other than recommended specifications may cause serious
problems.

Note  For further information of HDD specifications, refer to the applicable data sheet of
the HDD manufacturer.
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Troubleshooting

Table C-1 Frequently Asked Questions

Problem

Action

The system does not operate at all with no active
LED in the front panel.

Make sure that the system gets supplied with power properly.
Check the input voltage.

The unit continuously reboots.

Check if the system fan in a side panel of the unit or the CPU
fan inside the unit works properly.

If the fan fails, contact the retailer or the service center.
Disconnect the HDD cable and try to boot the system again. If
the system reboots successfully, install a new HDD and check
if the system starts recording normally.

The front LED is lit, but nothing is displayed on
the screen yet.

Check if your monitor supports the 1080p 60Hz HDMI, VGA
input.

Ensure that the input source settings of the monitor match
with the output source settings of the DVR.

If using the HDMI-to-DVI cable for the connection, ensure that
the input source is set to DVI.

Make sure that the system gets supplied with power properly.
Check the input voltage.

The sides of the video image are displayed
incomplete.

If the monitor is over-scanning the video, the sides can be
hidden. If this is the case, switch the display mode of the
monitor to the 1:1 pixel matching mode. Then, you will view
the video in full screen.

The 1:1 pixel matching is referred to differently depending on
the monitor manufacturer (for example, it is called JUST SCAN
for Samsung, ZERO OVERSCAN for LG, and so on). For
details, refer to your monitor’s user manual.

The camera is connected but no image is
displayed.

Make sure that the camera is compatible with the DVR. For the
compatibility of the cameras, contact the retailer.

Ensure that the output settings of the camera match with the
camera type settings of the DVR.
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Table C-1 Frequently Asked Questions (cont’d)

Problem

Action

It fails to connect to the web or mobile
application.

Check if the network cable is properly connected to the WAN
(UP Link) port of the unit.

You must have set the port forwarding if using a router.

If you cannot get access with the DDNS address, use the IP
address of the DVR instead.

If the DVR is connected to the router, use the IP address of the
DVR.

You can check the IP address of the router in NETWORK
STATUS » EXTERNAL IP ADDRESS.

| can access the web or mobile application but
still no video image is displayed.

You must have set the port forwarding if using a router.
This may happen when the communications provider or
network administrator has blocked the service port of the
DVR.

Change the RTSP port and HTTP port numbers to different
ones and set the port forwarding again.

Try to access the web or mobile application using the new
port numbers.
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License Agreement

Open Source License Report on the Product

The software included in this product contains copyrighted software that is licensed under the
GPL/LGPL.

GPL Software: linux kernel, busybox, cdrtools, dvd+rw-tools, smartctl, uboot, bash, udev,
sysklogd.

LGPL Software: glibc, vmstat, glib, gtk, ibESMTP, iconv, gstreamer, pango.
OpenSSL License: OpenSSL.
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alarm connections 35
alarm out schedule 93
alarm out settings 92
alarm recording settings 771
alarm sensor settings 97
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android
connecting to DVR 176
downloading app 775
log view 178
searching 178
setup 7179
split screen mode 177
archive devices setup 134
archive menu
archive devices setup 7134
creating new archive 729

opening during monitoring 729
opening during playback 729

playing archived data 132

reserved data management 737

audio device connection 37
audio input channel 50
audio mapping settings 7713
audio menu
audio options 72
buzzer options 73
audio options 72
auto sequence mode 48

backup player
getting started 787
overview 7183
player settings 785
printing 7184
video capturing 7184
bookmarking 726
buttons
alarm status, checking 57
audio input channel 50
auto sequence mode 48

digital zooming 49

disk status, checking 52

network status, checking 57

PTZ controls 48

quick log 50

saving snapshot 53

split screen mode 48
buzzer options 73

C

camera menu
camera title 56
covert setup 58
image setup 57
motion sensor 59
PTZ settings 61
setting motion area 60
tamper detection 62
camera title, setting 56
continuous recording
overview 108
schedule 709
size/fps/quality 7108
control device settings 87
covert setup options 58
creating new archive 729

D

date/time settings 82

DDNS settings 78

digital zooming 49

disk information 88

disk operations 90

disk status, checking 52

display menu
adding a sequence 67
editing a sequence 68
monitor settings 65
OSD settings 64
sequence settings 66
spot out settings 70

DVR
alarm 1/O connections 35
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audio device connection 37

basic system layout 33

compatible hard drives 7189

eSATA connection 38
logging out 44

login 43

monitor connection 34
network connection 38
NTSC/PAL switch 34
power connection 34
rear panel 28

RS-232 connection 37
RS-485 connection 37
specifications 7187
system shutdown 44
troubleshooting 797
USB connection 38

E

email settings 79

eSATA connection 38

event log, opening 50

event menu
alarm out schedule 93
alarm out settings 92
alarm sensor settings 97
event notification 94

event notification, buzzer 95
event natification, display 95
event notification, email 96
motion sensor settings 98
system event settings 700

installation
alarm I/O 35
audio device 37
eSATA device 38
monitor 34
network connection 38
NTSC/PAL switch 34
power 34
RS-232 device 37
RS-485 device 37
USB device 38

IP setup 77

iphone/ipad
connecting to DVR 170
downloading app 7170
log view 7173
searching 174
setup 775
split screen mode 172

L

live screen 45
logging out 44
login 43

M

mobile viewer
android 7175
ipad 170
iphone 170
overview 169

tamper event 103 recommended specifications 7169

video loss settings 99
event notification

buzzer output 95

display 95

email 96

setting 94
event search 720
exporting snapshot 54

F

features 26
firmware, upgrading 85

G

group authority, setting 76

H

hard drive, compatibility 789

image setup options 57

monitor connection 34
monitor settings 65
monitoring

live screen overview 45

quick menu 48

status bar 46

timeline 47

video window icons 46
motion area, setting 60
motion recording settings 770
motion sensor options 59
motion sensor settings 98

N

network connection 38
network map 871
network menu
DDNS settings 78
email settings 79
IP setup 77
network map 87
network status 80
network status, checking 57, 80
network streaming settings 772
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manual configuration 707
overview 106

OSD settings 64

P

package includes 27
panic recording settings 7712
playback
bookmarking 726
channel selection menu 725
controls 125
overview 123
screen configuration 724
playing archived data 132
power connection 34
PTZ controls 48
PTZ settings 61

Q

quick menu 48

R

rear panel 28

record setup menu
alarm recording settings 771
audio mapping settings 773

continuous recording settings 708

motion recording settings 770
network streaming settings 772
opening 705
operation mode settings 706
panic recording settings 772
regulatory 5
remote control 30
reserved data management 7137
RS-232 connection 37
RS-485 connection 37
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safety instructions 6, 25
saving snapshot 53
search menu
event search 720
opening while in playback 71716
opening while monitoring 775
thumbnail search 718
time search 7116
searching with web viewer 742
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adding 67
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settings 66
SMART settings 97
snapshot
exporting 54
saving 53
specifications 187
split screen mode 48
spot out settings 70
startup 43
status bar 46
storage menu
disk information 88
disk operations 90
SMART settings 97
system event settings
disk 100
network 702
overview 700
record system event 1071
system 701
system information 86
system layout, basic 33
system management settings 83
system menu
control device settings 87
date/time settings 82
opening 55
system information 86
system management settings 83
upgrading firmware 85
system shutdown 44

"

tamper detection, setting 62
tamper event settings 703
thumbnail search 718

time search 716

timeline 47

troubleshooting 7971

U

USB connection 38

user management
adding user account 74
editing user account 75
options 74

user menu
adding user account 74
editing user account 75
group authority settings 76
user management 74
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video loss settings 99
video window icons 46
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warranty 8

web viewer
about 167
activeX settings 740
alarm output settings 756
alarm recording settings 765
alarm sensor settings 758
audio settings 7150
camera title 746
capturing image 740
connection 735

continuous recording settings 762

control device setting 755
covert setting 747

date/time settings 754

DDNS settings 7153

email settings 753

event notification 756, 157
group permission settings 7152
IP setup 153

live screen 137, 138

log tab 741

login 136

monitor settings 750

motion recording settings 764
motion sensor settings 758
motion setting 747

network streaming settings 167

OSD settings 749
overview 135

panic recording settings 766

printing 740

PTZ setting 7148

PTZ tab 741

record settings 71671
saving the video 739
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